The symbols shown above are internationally accepted symbols that warn of potential hazards with electrical products. The lightning flash with arrow point in an equilateral triangle means that there are dangerous voltages present within the unit. The exclamation point in an equilateral triangle indicates that it is necessary for the user to refer to the owner's manual.

These symbols warn that there are no user serviceable parts inside the unit. Do not open the unit. Do not attempt to service the unit yourself. Refer all servicing to qualified personnel. Opening the chassis for any reason will void the manufacturer's warranty. Do not get the unit wet. If liquid is spilled on the unit, shut it off immediately and take it to a dealer for service. Disconnect the unit during storms to prevent damage.

SAFETY INSTRUCTIONS

NOTICE FOR CUSTOMERS IF YOUR UNIT IS EQUIPPED WITH A POWER CORD.

WARNING: THIS APPLIANCE MUST BE EARTHED.

The cores in the mains lead are colored in accordance with the following code:
GREEN and YELLOW - Earth
BLUE - Neutral
BROWN - Live

As colors of the cores in the mains lead of this appliance may not correspond with the colored markings identifying the terminals in your plug, proceed as follows:

- The core which is colored green and yellow must be connected to the terminal in the plug marked with the letter E, or with the earth symbol, or colored green, or green and yellow.
- The core which is colored blue must be connected to the terminal marked N or colored black.
- The core which is colored brown must be connected to the terminal marked L or colored red.

This equipment may require the use of a different line cord, attachment plug, or both, depending on the available power source at installation. If the attachment plug needs to be changed, refer servicing to qualified service personnel who should refer to the table below. The green/yellow wire shall be connected directly to the units chassis.

<table>
<thead>
<tr>
<th>CONDUCTOR</th>
<th>WIRE COLOR</th>
</tr>
</thead>
<tbody>
<tr>
<td>L</td>
<td>LIVE</td>
</tr>
<tr>
<td></td>
<td>BROWN</td>
</tr>
<tr>
<td></td>
<td>BLACK</td>
</tr>
<tr>
<td>N</td>
<td>NEUTRAL</td>
</tr>
<tr>
<td></td>
<td>BLUE</td>
</tr>
<tr>
<td></td>
<td>WHITE</td>
</tr>
<tr>
<td>E</td>
<td>EARTH GND</td>
</tr>
<tr>
<td></td>
<td>GREEN/TEL</td>
</tr>
<tr>
<td></td>
<td>GREEN</td>
</tr>
</tbody>
</table>

WARNING: If the ground is defeated, certain fault conditions in the unit or in the system to which it is connected can result in full line voltage between chassis and earth ground. Severe injury or death can then result if the chassis and earth ground are touched simultaneously.

LITHIUM BATTERY WARNING

CAUTION!

This product may contain a lithium battery. There is danger of explosion if the battery is incorrectly replaced. Replace only with an Eveready CR 2032 or equivalent. Make sure the battery is installed with the correct polarity. Discard used batteries according to manufacturer's instructions.

ADVARSEL!


ADVARSEL!

Lithiumbatteri - Eksplosionsfare ved fejlagtig håndtering. Udskiftningsmå kun ske med batteri af samme fabrikat og type. Levér det brugte batteri tilbage til leverandøren.

VAROITUS!

Paristo voi räjähtää, jos se on virheellisesti asennettu. Vaihda paristo ainoastaan laitevalmistajan suosittelemaan tyyppin. Hävitä käytetty paristo valmistajan ohjeiden mukaisesti.

WARNING!


ELECTROMAGNETIC COMPATIBILITY

This unit conforms to the Product Specifications noted on the Declaration of Conformity. Operation is subject to the following two conditions:

- this device may not cause harmful interference, and
- this device must accept any interference received, including interference that may cause undesirable operation.

Operation of this unit within significant electromagnetic fields should be avoided.

- use only shielded interconnecting cables.
**IMPORTANT SAFETY INFORMATION**

**WARNING FOR YOUR PROTECTION**

**PLEASE READ THE FOLLOWING:**

**KEEP THESE INSTRUCTIONS**

**HEED ALL WARNINGS**

**FOLLOW ALL INSTRUCTIONS**

**DO NOT USE THIS APPARATUS NEAR WATER**

**CLEAN ONLY WITH A DRY CLOTH.**

**DO NOT BLOCK ANY OF THE VENTILATION OPENINGS. INSTALL IN ACCORDANCE WITH THE MANUFACTURER’S INSTRUCTIONS.**

**DO NOT INSTALL NEAR ANY HEAT SOURCES SUCH AS RADIATORS, HEAT REGISTERS, STOVES OR OTHER APPARATUS (INCLUDING AMPLIFIERS) THAT PRODUCE HEAT.**

**ONLY USE ATTACHMENTS/ACCESSORIES SPECIFIED BY THE MANUFACTURER.**

**UNPLUG THIS APPARATUS DURING LIGHTNING STORMS OR WHEN UNUSED FOR LONG PERIODS OF TIME.**

Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two blades and a third grounding prong. The wide blade or third prong are provided for your safety. If the provided plug does not fit your outlet consult an electrician for replacement of the obsolete outlet.

Protect the power cord from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit from the apparatus.

Use only with the cart stand, tripod bracket, or table specified by the manufacture, or sold with the apparatus. When a cart is used, use caution when moving the cart/apparatus combination to avoid injury from tip-over.

Refer all servicing to to qualified service personnel. Servicing is required when the apparatus has been damaged in any way, such as power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does not operate normally, or has been dropped.

**POWER ON/OFF SWITCH:** For products provided with a power switch, the power switch DOES NOT break the connection from the mains.

**MAINS DISCONNECT:** The plug shall remain readily operable. For rack-mount or installation where plug is not accessible, an all-pole mains switch with a contact separation of at least 3 mm in each pole shall be incorporated into the electrical installation of the rack or building.

**FOR UNITS EQUIPPED WITH EXTERNALLY ACCESSIBLE FUSE RECEPTACLE:** Replace fuse with same type and rating only.

**MULTIPLE-INPUT VOLTAGE:** This equipment may require the use of a different line cord, attachment plug, or both, depending on the available power source at installation. Connect this equipment only to the power source indicated on the equipment rear panel. To reduce the risk of fire or electric shock, refer servicing to qualified service personnel or equivalent.

---

**U.K. MAINS PLUG WARNING**

A molded mains plug that has been cut off from the cord is unsafe. Discard the mains plug at a suitable disposal facility. NEVER UNDER ANY CIRCUMSTANCES SHOULD YOU INSERT A DAMAGED OR CUT MAINS PLUG INTO A 13 AMP POWER SOCKET. Do not use the mains plug without the fuse cover in place. Replacement fuse covers can be obtained from your local retailer. Replacement fuses are 13 amps and MUST be ASTA approved to BS1362.

---

**DECLARATION OF CONFORMITY**

Manufacturer’s Name: DigiTech
Manufacturer’s Address: 8760 S. Sandy Parkway
Sandy, Utah 84070, USA

declares that the product:

Product name: RPx400
Product option: all (requires Class II power adapter that conforms to the requirements of EN60065, EN60742, or equivalent.)

conforms to the following Product Specifications:

- **Safety:** IEC 60065 (1998)
- **EMC:** EN 55013 (1990)
  - EN 55020 (1991)

Supplementary Information:


Vice-President of Engineering
8760 S. Sandy Parkway
Sandy, Utah 84070, USA
Date: April 17, 2003

European Contact: Your local DigiTech Sales and Service Office or

Harman Music Group
8760 South Sandy Parkway
Sandy, Utah 84070 USA
Ph: (801) 566-8800
Fax: (801) 568-7583
Warranty

We at DigiTech are very proud of our products and back-up each one we sell with the following warranty:

1. The warranty registration card must be mailed within ten days after purchase date to validate this warranty.

2. DigiTech warrants this product, when used solely within the U.S., to be free from defects in materials and workmanship under normal use and service.

3. DigiTech liability under this warranty is limited to repairing or replacing defective materials that show evidence of defect, provided the product is returned to DigiTech WITH RETURN AUTHORIZATION, where all parts and labor will be covered up to a period of one year. A Return Authorization number may be obtained from DigiTech by telephone. The company shall not be liable for any consequential damage as a result of the product’s use in any circuit or assembly.

4. Proof-of-purchase is considered to be the burden of the consumer.

5. DigiTech reserves the right to make changes in design, or make additions to, or improvements upon this product without incurring any obligation to install the same on products previously manufactured.

6. The consumer forfeits the benefits of this warranty if the product’s main assembly is opened and tampered with by anyone other than a certified DigiTech technician or, if the product is used with AC voltages outside of the range suggested by the manufacturer.

7. The foregoing is in lieu of all other warranties, expressed or implied, and DigiTech neither assumes nor authorizes any person to assume any obligation or liability in connection with the sale of this product. In no event shall DigiTech or its dealers be liable for special or consequential damages or from any delay in the performance of this warranty due to causes beyond their control.

NOTE: The information contained in this manual is subject to change at any time without notification. Some information contained in this manual may also be inaccurate due to undocumented changes in the product or operating system since this version of the manual was completed. The information contained in this version of the owner’s manual supersedes all previous versions.
# Table Of Contents

**Introduction**  ........................................ 1
   Included Items .................................... 1
   The Front Panel .................................. 1
   Rear Panel ........................................ 2
   Making Connections  ............................... 4
   Mono Amp Rig ...................................... 4
   Stereo Amp Rig .................................... 4
   Amp / PA Rig  ....................................... 5
   Recording Setup .................................... 5
   Applying Power ..................................... 6
   The Presets ......................................... 7
   Performance ....................................... 7
   Bypass ............................................... 7
   Tuner ............................................... 7
   Learn-A-Lick Mode ................................ 8
   CD/Monitor In ...................................... 8
   Drum Machine ....................................... 9
   Mic Input and Level ................................ 9

**Creating Presets**  ................................. 10
   Editing/Creating Presets  ......................... 10
   The Matrix ......................................... 10
   Storing/Copying/Naming a Preset .................. 10
   About the Effects .................................. 12
   Pickup/Wah ......................................... 12
   Amp Modeling/Cabinet  .............................. 13
   EQ .................................................. 14
   Noise Gate ......................................... 14
   Chorus/Mod Effects  ................................ 15
   Chorus ............................................. 15
   Flange ............................................. 15
   Triggered Flanger .................................. 15
   Phaser .............................................. 16
   Triggered Phaser ................................... 16
   Tremolo ............................................. 16
   Panner .............................................. 17
   Rotary Speaker ..................................... 17
   YaYa™ .............................................. 17
   AutoYa™ ............................................. 17
   SynthTalk™ ......................................... 18
   Envelope Filter ..................................... 18
   Detune .............................................. 18
   Pitch Shift ......................................... 18
   Whammy™ ........................................... 19
   Delay ................................................. 19
   Reverb .............................................. 19
   Expression Pedal .................................... 20
   V-Switch ............................................ 21
   LFO .................................................. 21

**RPx400 Setups**  ................................ 22
   Setups Introduction ................................ 22
   Mic / Line Setups  ................................. 22
   Speaker Compensation and Output Modes ....... 23

**The RPx400 and Recording**  ...................... 25
   Recording Introduction  ......................... 25
   Installing RPx400 USB Drivers ................... 25
   Windows XP Users .................................. 25
   Windows 2000 Users ................................ 26
   Installing X-Edit Editor Librarian ............... 26
   Connecting the RPx400 to the Computer ........... 27
   RPx400 Recording Setup  ......................... 27
   Using Pro Tracks .................................. 30
   Installing Pro Tracks Software .................... 30
   Setting Up the RPx400 MIDI Device ............... 30
   Setting up the RPx400 for Hands-Free Recording 30
   Setting up Pro Tracks for RPx400 Audio ......... 30
   Using the RPx400’s Footswitches for Recording ... 31
   Recording a Track or Tracks  ...................... 31
   Recording Multiple Tracks  ......................... 32
   Re-Amping a Guitar Track  ......................... 32
   RPx400 Drums and MIDI  ............................ 34
   Recording the RPx400 Drums  ...................... 34
   Playback Mix ....................................... 34
   USB 1-2 Level /USB 3-4 Level ....................... 35
   Using the RPx400’s Footswitches for Recorder Functions .... 35

**Utilities** ........................................ 36
   Expression Pedal Calibration ...................... 36
   V-Switch Sensitivity ................................ 36

**Trouble Shooting Guide**  ......................... 37

**Appendix** ...................................... 39
   CC Parameter List .................................. 39
   Factory Preset List ................................ 40
   Specifications: .................................... 40

---

**Introduction**

- Included Items
- The Front Panel
- Rear Panel
- Making Connections
- Mono Amp Rig
- Stereo Amp Rig
- Amp / PA Rig
- Recording Setup
- Applying Power
- The Presets
- Performance
- Bypass
- Tuner
- Learn-A-Lick Mode
- CD/Monitor In
- Drum Machine
- Mic Input and Level

**Creating Presets**

- Editing/Creating Presets
- The Matrix
- Storing/Copying/Naming a Preset
- About the Effects
- Pickup/Wah
- Amp Modeling/Cabinet
- EQ
- Noise Gate
- Chorus/Mod Effects
- Chorus
- Flange
- Triggered Flanger
- Phaser
- Triggered Phaser
- Tremolo
- Panner
- Rotary Speaker
- YaYa™
- AutoYa™
- SynthTalk™
- Envelope Filter
- Detune
- Pitch Shift
- Whammy™
- Delay
- Reverb
- Expression Pedal
- V-Switch
- LFO

**RPx400 Setups**

- Setups Introduction
- Mic / Line Setups
- Speaker Compensation and Output Modes
Introduction

Congratulations on your purchase of the RPx400. The RPx400 is truly a breakthrough in guitar processing technology, providing the tools you need for live performance and the professional features you need in the recording studio. We recommend that you take the time to become better acquainted with what the RPx400 has to offer by going through this User’s Guide with your RPx400 in front of you.

Included Items

Before you get started, please make sure that the following items have been included:

- RPx400 Modeling Guitar Processor
- X-Edit Software CD
- USB Cable
- PS0913B Power Supply
- Warranty Card

The utmost care was taken while your RPx400 was being manufactured. Everything should be included and in perfect working order. If anything is missing, contact the factory at once. Please help us become acquainted with you and your needs by completing your warranty card. It is your safeguard should a problem arise with your RPx400.

The Front Panel

1. Down/Up Footswitches - These two footswitches are used to select presets, access the Tuner, or bypass the RPx400. The footswitch on the left decreases, and the middle footswitch increases the preset number. Pressing both footswitches together bypasses the selected preset. Press and hold both Footswitches to access the Tuner.
Introduction

2. Amp A/B Footswitch - This footswitch switches between two amp channels for the selected preset. It is also used in conjunction with the Up Footswitch, to access Learn-A-Lick, or the recorder functions when the RPx400 is connected to your computer via USB.

3. Knobs - These knobs perform various functions depending on which mode is selected or whether the RPx400 is connected to your computer via USB. During performance, the knobs control the Amp Gain, Bass EQ, Mid EQ, Treble EQ, and Master Level. If the RPx400 is connected to the computer via USB, the performance functions of knobs 2, 3, and 4 are Playback Mix, USB 1-2 Send Level, and USB 3-4 Send Level. When editing or accessing the Setup functions, the knobs adjust the parameter values listed directly above each knob for the selected effect. When the Drum Machine is on, the knobs control the Pattern, Tempo, and Level. In Tuner mode, the knobs are used to select the tuning reference.

4. Select Button - This button enters the Edit mode, and selects individual effects to be edited. Successive presses of this button advances through all available effects. It is also used to change playback speed in Learn-A-Lick mode.

5. Drums - The Drums button turns the built-in drum machine on and off. When the drum machine is active, the Drums LED lights and the selected drum pattern plays continuously.

6. Matrix - The matrix provides information regarding the current preset, and parameter edit functions. In performance mode, the LEDs running down the left side of the Matrix identify which effects are in use for the selected preset. In Edit mode, the LEDs indicate the effect selected for editing.

7. Display - The display provides information for different functions depending on the mode that is active. In Performance mode, the display shows the selected preset name and numeric location. In Edit mode, the display shows the name and value of the selected parameter. In Tuner mode, the display shows the note being played and whether the note is sharp, flat, or in tune.

8. Store - The Store button saves your changes to a User Preset.

9. Expression Pedal - The Expression Pedal adjusts the RPx400's assigned Effect Parameter in real time. Almost every Parameter is available for Expression Pedal control.

Rear Panel

1. Guitar In - Connect your instrument to this jack.
2. Mic Level - Controls the gain of the Mic Input.

3. Mic Input - Connect a mic here for recording or live performance mixing of acoustic sources into the RPx400. Mic signals can remain dry or be processed through the RPx400 effects for both live recording applications. Accepts either dynamic or phantom powered condenser microphones.

4. Left/Right Line Inputs - Connect line level sources to these jacks for recording or live performance mixing into the RPx400. Line signals can remain dry or be processed through the RPx400 effects for live and recording applications.

5. CD/Monitor In - Connect the output of a CD or MP3 player headphone out when using the Learn-a-Lick Phrase Trainer feature (see page 8 for more on Learn-a-Lick). Can also be used as a monitor input for mixing the output of your computer's sound card back into the RPx400 for playback monitoring.

**Note:** Using the CD/Monitor input for any type of real-time recording monitoring may result in a time delay depending on your computer's speed.

6. Headphones - Connect a pair of stereo headphones to this 1/8" jack.

7. 1/4" Line Outputs - Connect these outputs to your amplifier or to a mixing console that accepts 1/4" unbalanced connections. Speaker Compensation can be enabled on these outputs when connected to a full-range speaker system (see page 23 for more about Speaker Compensation usage).

8. Balanced Line Outputs - Connect these outputs to your power amplifier/speaker system or to a mixing console that accepts balanced XLR connections. Speaker Compensation can be enabled on these outputs when connected to a full-range speaker system. (see page 23 for more about Speaker Compensation usage).

9. USB Jack - Connect this jack to your computer's USB port for recording purposes (see page 25 for more on using the RPx400's USB functions).

**ATTENTION:** Install the USB drivers provided on the X-Edit Software CD before connecting the RPx400 to your computer with the USB cable. This will ensure that the RPx400 will be recognized as your recording sound source for the Pro-Tracks™ recording software.

10. Power Input - Connect only the DigiTech PS0913B power supply to this jack.

11. Footswitch - Connect the RPxFc 3-button footswitch to this jack. The RPxFc provide remote control of the recording functions of the RPx400 (see page 35 for more on using the RPxFc functions).
Making Connections
There are several different connection options available with the RPx400. Before connecting the RPx400, make sure that the power to your amplifier and the RPx400 is turned off. The RPx400 does not have a power switch. To turn the RPx400 off, disconnect the included PS0913B power supply from the power jack to an AC outlet.

Mono Amp Rig
Connect your guitar to the Input of the RPx400. Connect a single mono instrument cable from the Left 1/4" Line Output of the RPx400 to the instrument input or effect return on your amplifier. This connection scheme also applies for use with a power amp/speaker cabinet rig.

Stereo Amp Rig
Connect your guitar to the Input of the RPx400. Connect a two mono instrument cable from the Left and Right 1/4" Line Outputs of the RPx400 to the instrument inputs or effect returns on each of your amplifiers. This connection scheme also applies for use with a power amp/speaker cabinet rig.

NOTE: When using a guitar amp, it may be best to connect the guitar to the Input of the RPx400 and the Output of the RPx400 to the effect return of the amplifier to avoid coloration of the tone due to the amplifier's tone controls.
Amp / PA Rig
Connect your guitar to the Input of the RPx400. Connect a mono instrument cable from the Left or Right 1/4” Line Output of the RPx400 to the instrument input or effect return on your amplifier or power amp/speaker cabinet rig. Connect the balanced XLR Left and Right outputs to the inputs on your PA mixer and pan each of these channels hard left and hard right. Select SC XLR as your Output Mode (see Output Modes on pg 23). This enables Cabinet Simulation on the feeds to the mixer and PA but not to your guitar amp onstage. This connection scheme also applies for use with a power amp/speaker cabinet rig.

Recording Setup
This is the classic recording setup utilizing the RPx400’s mic and line inputs and a pair of powered reference monitors connected the RPx400’s XLR outputs. This setup can also be used for live applications where you would be performing along with playback from the Pro Tracks, recording software running on your computer. See the Output Modes section on page 23 on how the XLR and 1/4” outputs and Speaker Compensation can be implemented for various recording and live applications.
Applying Power

Before applying power to anything, set your amp(s) to a clean tone and set the tone controls to a flat EQ response (on most amps, this would be 0 or 5 on the tone controls). Then do the following:

1. Turn the amp volume all the way down.
2. Connect the plug of the PS0913B power supply to the Power Jack.
3. Connect the other end of the PS0913B power supply to an AC outlet and turn the Master Level knob until the display reads \texttt{MLEVEL 0}.
4. Turn your amplifier(s) on and adjust the volume(s) to a normal playing level.
5. Gradually increase the RPx400’s Master Level to the desired listening level.
The Presets
Presets are named and numbered locations of programmed sounds which reside in the RPx400. Presets are recalled with the footswitches. The active effects in each preset are indicated by the lighted LEDs in the Effect Matrix. The RPx400 comes with 40 User Presets (Presets U1-U40), 40 Factory Artist Presets (Presets A1-A40), and 40 DigiTech factory presets (F1-F40). The User Presets are locations where you can store your edits. You may not store changes to the Artist/Factory Presets. From the factory, the 40 User Presets are exact duplicates of the 40 Factory Artist Presets.

Performance
When you first apply power to the RPx400, it powers up in Performance mode. Performance mode provides access to all of the presets within the RPx400 via the Up and Down Footswitches. The Number 1 Knob (left) adjusts the Gain for the selected Amp Type, the Number 2 Knob (second from the left) adjusts the amount of Bass enhancement, the Number 3 Knob (middle) adjusts the amount of Mid-range enhancement, the Number 4 Knob (second from the right) adjusts the amount of Treble (high frequency) enhancement, and the Number 5 Knob (right) adjusts the Master Level (volume).

Bypass
The RPx400 Presets can be bypassed for a clean, unprocessed guitar tone. To bypass the RPx400, press both the Up and Down Footswitches simultaneously. The display read Bypass indicating the preset is bypassed. Pressing any of the 3 Footswitches exits Bypass and returns the RPx400 to the previously selected preset.

Tuner
The Tuner lets you quickly tune or check the tuning on your guitar. Enter Tuner mode by pressing and holding the Up and Down Footswitches simultaneously. The display briefly shows tuner indicating that you are in Tuner mode. To begin tuning, play a note on your guitar (a harmonic at the 12th fret usually works best). The right 2 characters in the display shows the note being played. The left characters in the display indicate whether you are sharp or flat. Arrows pointing to the left (<<<) indicate the note is sharp and should be tuned down. Arrows pointing to the right (>>>) indicate the note is flat and should be tuned up. When the note is in tune, the display shows <<<. In Tuner mode, you can change your tuning reference. The default factory setting is A=440 Hz. (displayed as A=440). Rotate the Number 1 Knob to select alternate dropped tunings. Alternate tunings are A = Ab, A = G, and A = Gb. The display window briefly flashes the selected tuning preference.

The output is muted in Tuner mode. The Expression Pedal returns sound to the output allowing signal to be heard while tuning. Exit tuner mode by pressing any of the 3 Footswitches.
Introduction

Learn-A-Lick Mode
Learn-A-Lick lets you record a 10 second passage of music and play it back as slow as 1/4 speed without a change in pitch. This is useful for picking out the notes of a fast solo passage.

There are 6 functions for Learn-A-Lick including:
- Stop (Controlled by the Down Footswitch)
- Rewind (Controlled by the Up Footswitch)
- Play (Controlled by the Down Footswitch)
- Record (Controlled by the Amp A-B Footswitch)
- Playback Speed (Controlled with Select Button)
- Sampled Phrase Volume (Controlled by the Expression Pedal)

Using Learn-A-Lick
1. Connect your MP3/CD/tape player headphone output to the CD/Monitor input jack on the rear panel using an 1/8” stereo plug. Set the level of the MP3/CD/tape player to a desired listening level.
2. Cue up to the passage you want to record and press pause on the MP3/CD/tape player.
3. Press and hold the Up and Amp A-B Footswitches to access Learn-A-Lick mode. The display briefly reads: LALICK.
4. When the display reads READY, release the pause button on your playback device and press the Amp A-B (Record) Footswitch. The display reads: RCRDNG and the right two display digits provide a time elapsed reference while recording. When recording is complete, the phrase is set to an auto-loop playback mode indicated by play in the display. Press stop or pause on the MP3/CD/tape player.
5. Use the Select button to choose the playback speed. Successive presses of the Select button advance through each playback speed up to 1/4th of the original speed. Your interval choices include: 1/4, 3/8, 1/2, 5/8, 3/4, 7/8, and Full.
6. Press the Up Footswitch to step back through the loop at 1 second intervals.
7. The Expression Pedal controls the output level of the recorded phrase.
8. To stop or restart the playback, press the Down (Stop/Play) Footswitch.
9. To record a new passage, press the Amp A-B (Record) Footswitch again.
10. To exit the Learn-A-Lick mode, press and hold the Up and Amp A-B Footswitches simultaneously.

Note: Learn-a-Lick is not available when the RPx400 is connected to the computer via USB.

CD/Monitor In
The CD In feature lets you connect a CD, MP3, or tape player to the RPx400, and play along with your favorite artists. To use the CD In feature, do the following:
1. Connect the headphone output of your MP3/CD/tape player to the CD/Monitor input using an 1/8” stereo cable.
2. Press play on your MP3/CD/tape player. The signal from your MP3/CD/tape player is routed to the left, right, and headphone outputs of the RPx400.
Drum Machine

The RPx400 features a Drum machine that includes several sampled drum patterns which are useful for developing a good sense of timing. Pressing the Drums button turns on the built-in drum machine (except when in Store or Bypass mode). When the drum machine is active:

The Number 1 Knob is used to select the drum Pattern. Choices include:

- **ROCK 1**, **ROCK 2**, **ROCK 3**, **HROCK1**, **HROCK2**, **HROCK3**
- **POP1**, **POP2**, **POP3**, **POP4**, **POP5**
- **DANCE1**, **DANCE2**, **DANCE3**, **ENTRY1**, **ENTRY2**
- **BLUES1**, **BLUES2**
- **JAZZ**, **FUNK 1**, **FUNK 2**
- **SWING1**, **SWING2**
- **URBAN1**, **URBAN2**, **REGGAE**
- **CHA 1**, **CHA 2**
- **FOSSA**, **BOSSA**
- **MTRNOM**

The Number 2 Knob adjusts the drum Tempo and ranges from BPM 40 (40 beats per minute) to BPM 240 (240 beats per minute).

The Number 3 Knob adjusts the volume Level of the drum loop and ranges from 1 to 99.

Press the Drums button again to stop playback of the drum loop.

Mic Input and Level

The RPx400 features a mic input that be used for mixing or recording vocals and acoustic instruments. The mic input is equipped with phantom power that can power professional condenser microphones. The mic preamp is controlled via the Level knob for controlling the gain of the mic signal. To set the mic level control, follow these steps:

1. Connect a set of headphones to the headphone jack.
2. Sing or play at the loudest volume you will be performing at and adjust the Level control until any audible distortion is minimized. This is the optimum setting for the Mic Level.

For application uses of the mic input, see both the Connections and RPx400 Setups sections of this user’s guide.
Creating Presets

Creating your own signature sound with the RPx400 is easy and intuitive. The RPx400 lets you create your own presets, or fine tune existing presets to suit your needs. When creating or editing a sound, you must start with one of the User, Artist Factory, or Factory Presets. It is not possible to start with an empty preset. The preset number does not need to be the location that you intend to save it to, because you can save it to any User Preset location during the store process.

To edit or create a Preset:
1. Use the Up or Down Footswitches to select a preset.
2. Once you have found a preset that you want to edit, press the Select button once to enter Edit mode.
3. Use the Select button in conjunction with the Matrix LEDs to choose the effect you want to edit.
   Successive presses of the Select button advance to the next Effect in the Matrix.
4. Use the 5 Knob to change parameter values.
5. Store your preset. See this page for more on storing a preset.

The Matrix

The Matrix identifies the effects and parameters selected for editing. In Edit mode, successive presses of the Select button advance to the next row of effects. The LED lights indicating which effect group is selected. Each effect group has up to 5 parameters that can be modified. The knob directly below each column is used to change the parameter value of the selected effect. As a knob is rotated, the corresponding parameter’s name and value or status are displayed.

When the stored value of a parameter is changed, the Store LED lights indicating you need to store the changes. Changing presets, or turning the power off before storing erases all changes made and the RPx400 reverts to the stored values for the preset.

Storing/Copying/Naming a Preset

Once the preset is modified, you may store your settings to any of the 40 User Preset locations (Presets U1-U40). The following steps outline the procedure for storing changes to a preset or copying a preset to a different location:
Creating Presets

1. Press the Store button once. The Store button LED blinks and the first character in the display flashes indicating you can name your new preset.

2. Use the Number 1 Knob or Up/Down Footswitches to select the alpha-numeric character.

3. Rotate the Number 2 Knob clockwise to select the next character, and counterclockwise to select the previous character. Repeat step 2 until the name is complete.

4. Once the name is shown in the display, press the Store button. The display alternates between the new name and the name of the preset about to be overwritten.

5. Select the User Preset location of your new preset using the Number 5 Knob or the Up/Down Footswitches. The display continues to alternate between the new preset name and name of the preset about to be overwritten.

6. Press the Store button again to save the changes.

Press the Select or Drums buttons at any time to abort storing.

To copy one preset to another preset location is the same as above. Use the footswitches to select the preset that you want to copy, then follow the steps listed above.
Creating Presets

RPx400’s Effects

About the Effects

The RPx400 can be thought of as several different “virtual” amplifiers and individual, hi-tech stomp boxes in a single programmable package. With stomp boxes, the order in which they are connected can drastically affect the overall sound quality. The RPx400 has placed the effects in an order for optimum sound quality. The following diagram shows the order of the effects.

---

Effect Definitions

Each effect within the RPx400 can be programmed to suit your personal taste and application. Understanding how these effects alter the sound, and how each parameter alters the effect helps you achieve the sound you are looking for. The following overview of the RPx400’s effects outlines what each effect and parameter does.

**Pickup/Wah**

The Pickup Simulator provides the thick tone of a humbucker pickup to a guitar with single coil pickups, or the bright edgy sound of a single coil pickup to a guitar with a humbucker. This lets you have the best of both worlds without having to change guitars during a performance.

Wah is an effect controlled by the Expression Pedal. As the Expression Pedal is rocked back and forth, it makes the guitar sound as if it is saying “Wah.” The Wah is engaged and disengaged by applying pressure to the V-Switch located under the toe of the Expression Pedal. See Page 21 for more information regarding the V-Switch.

- **Pickup Off/Type** - The Number 1 Knob selects the type of Pick Up to be be simulated. Values include: *SC> <HUM* (Gives a single coil pick up the warm tone of a humbucker), and *HUM> SC* (Gives a humbucker the unique sound of a single coil), or turns Pickup Simulation off.
- **Wah On/Off** - The Number 2 Knob turns the Wah effect on or off.
- **Wah Type** - The Number 3 Knob selects the type of Wah. Values include: *CRY* (Cry Wah is a traditional sounding Wah), *BOUTIQ* (Boutique Wah is a wide sweeping Wah with a more modern sound) and *FULRNG* (Full Range Wah sweeps the entire spectrum of audible frequencies).
- **Wah Minimum** - The Number 4 Knob is used to select the minimum point the Wah reaches in the toe up position of the Expression Pedal. Ranges from 1 to 99.
- **Wah Maximum** - The Number 5 Knob is used to select the maximum point the Wah reaches in the toe down position of the Expression Pedal. Ranges from 1 to 99.

**Compressor**

A Compressor is used to increase sustain, tighten up the guitar signal, and prevent the signal from clip-
ping the input of other effects. It sets a maximum boundary (Threshold) for the strength of a signal. If a signal exceeds the Threshold, it is adjusted based upon the compression ratio setting.

**Comp On/Off** - The Number 1 Knob turns the Compressor on (On) and off (Off).

**Attack** - The Number 2 Knob adjusts the length of time it takes for the Compressor to respond to a signal exceeding the Threshold. Values include: fast, medium, and slow.

**Ratio** - The Number 3 Knob adjusts the input to output ratio once the Threshold has been exceeded. For instance, a Ratio of 4 to 1 means that a signal exceeding the Threshold by 4 dB will only be allowed 1 dB of increased output. Ranges include: 1.2-1 (1.2 to 1), 1.5-1 (1.5 to 1), 1.8-1 (1.8 to 1), 2.0-1 (2 to 1), 2.5-1 (2.5 to 1), 3.0-1 (3 to 1), 4.0-1 (4 to 1), 5.0-1 (5 to 1), 8.0-1 (8 to 1), 10-1 (10 to 1), 20-1 (20 to 1), and 00-1 (infinity to 1).

**Threshold** - The Number 4 Knob adjusts the maximum strength the signal is allowed to reach before the compressor begins to work. Ranges from 1 to 99.

**Gain** - The Number 5 Knob adjusts the Output Gain from the Compressor. Ranges from 0 to 6 (dB).

## Amp Modeling/Cabinet

Amp Modeling is a technology that applies a vintage or modern amp tone to your guitar signal. The RPx400’s Amp Modeling also provides an acoustic guitar simulation. The Amp Modeling section includes an A and a B channel. Each channel can be individually programmed to include different settings for Amp Gain, Amp Level, Cabinet Type, Mic Position, and EQ. This allows you to switch from a clean to a distorted setting while retaining all other Effects settings. Switching Amp channels is accomplished instantly with the Amp A/B Footswitch.

The Cabinet Modeling simulates different types of miked speaker cabinets. You have your choice of 6 Cabinet Types and 4 Mic Placements in relationship to each speaker cabinet.

**Amp Channel** - The Number 1 Knob selects the A or B channel. You may also use the A/B Footswitch to select the amp channel during the editing process.

**Amp Type** - The Number 2 Knob selects one of the Amp Models or Acoustic Simulator. Choices include:

- **DIRECT** - Turns the modeling off
- **BLKFAC** - Based on a ’65 Fender Twin Reverb
- **BOUTIQ** - Based on a Matchless DC30
- **RECTIF** - Based on a Mesa Dual Rectifier
- **HOTROD** - Based on a Mesa Boogie Mark II C
- **TWEED** - Based on a ’57 Fender Tweed Deluxe
- **CLEAN1** - Based on a Vox AC30 top boost
- **CLEAN2** - A clean tube combo setting
- **STACK** - Based on a Marshall JCM900
- **CRUNCH** - A nice crunchy combo
- **HIGAIN** - Based on a Johnson JM150 High Gain
- **FUZZ** - A vintage fuzz distortion
- **ACOUST** - A flat top acoustic guitar

Creating Presets

Marshall® is a registered trademark of Marshall Amplification Plc. Vox® is a registered trademark of Korg UK. Fender, Matchless, and Mesa Boogie, are trademarks of their respective companies and are in no way associated with DigiTech.

**Amp Gain** - The Number 3 Knob adjusts the Gain (distortion) for the selected Amp Model (not available for Acoustic). The Gain parameter ranges from 0 to 99.

**Amp Level** - The Number 4 Knob adjusts the Level (volume) of the selected Amp Model. The Level parameter ranges from 1 to 99.

**Cabinet-Mic** - The Number 5 Knob selects the type of cabinet model as well as mic placement in relation to the speaker. Your choices include:
Creating Presets

| DIRECT - Cabinet Off | 2x12G 1 - 4x12 British Mic 1 |
| 1x12 1 - 1x12 Mic 1 | 2x12G 2 - 4x12 British Mic 2 |
| 1x12 2 - 1x12 Mic 2 | 2x12G 3 - 4x12 British Mic 3 |
| 1x12 3 - 1x12 Mic 3 | 2x12G 4 - 4x12 British Mic 4 |
| 1x12 4 - 1x12 Mic 4 | 4x12V 1 - 4x12 Vintage Mic 1 |
| 2x12O 1 - 2x12 Open Back Mic 1 | 4x12V 2 - 4x12 Vintage Mic 2 |
| 2x12O 2 - 2x12 Open Back Mic 2 | 4x12V 3 - 4x12 Vintage Mic 3 |
| 2x12O 3 - 2x12 Open Back Mic 3 | 4x12V 4 - 4x12 Vintage Mic 4 |
| 2x12O 4 - 2x12 Open Back Mic 4 | 4x12G 1 - 4x12 Green Mic 1 |
| 2x12C 1 - 2x12 Closed Back Mic 1 | 4x12G 2 - 4x12 Green Mic 2 |
| 2x12C 2 - 2x12 Closed Back Mic 2 | 4x12G 3 - 4x12 Green Mic 3 |
| 2x12C 3 - 2x12 Closed Back Mic 3 | 4x12G 4 - 4x12 Green Mic 4 |
| 2x12C 4 - 2x12 Closed Back Mic 4 |

The following diagram shows the difference between the Mic 1 through Mic 4 selections:

EQ

Equalization is an extremely useful tool used to further shape the tonal response of your guitar signal. The EQ in the RPx400 is similar to the tone knobs on an amplifier. All three EQ parameters range from -12dB to +12 dB.

EQ On/Off - The Number 1 Knob turns the EQ on (On) and off (OF).
Bass - The Number 2 Knob adjusts the amount of low end enhancement.
Mid Frequency - The Number 3 Knob selects the frequency to which the boost will be applied by the mid level knob. Ranges from 500Hz (500 Hz.) to 3000Hz (3000 Hz.)
Mid Level - The Number 4 Knob adjusts the amount of mid range enhancement.
Treble - The Number 5 Knob adjusts the amount of high end enhancement.

Noise Gate

A Noise Gate is designed to eliminate hiss and ambient noise while you are not playing. A Noise Gate can also be used to create an automatic swell in volume. The RPx400 includes two different types of Noise Gates: Silencer™, and Pluck. The Silencer™ operates as a standard Noise Gate. The Pluck Noise Gate is designed to close after every note (depending on the Pluck Sensitivity). This allows automatic volume swells to occur on a note by note basis.
Gate On/Off - The Number 1 Knob turns the Noise Gate on (On) and off (Off).

Gate Type - The Number 2 Knob selects between the Silencer™ (SILNCR) or Pluck (PLUCK) type of Noise Gates.

Gate Attack - The Number 3 Knob adjusts the length of time it takes the gate to open once the Threshold has been exceeded before the signal becomes audible. Ranges from 1 (immediate signal), to 9 (Selects the Auto Swell volume swell effect. This setting will gradually ramp up the volume).

Gate Threshold - The Number 4 Knob sets the signal strength required to open or close the Noise Gate. The Gate Threshold parameter ranges from 1 (opens easily) to 40 (requires strong signals to open).

Pluck Sensitivity - The Number 5 Knob controls the point where the Gate re-triggers when using the Pluck type Noise Gate. This Parameter is only available when Pluck is the selected type of Noise Gate. Ranges from 1 (requires strong signals to re-trigger) to 99 (re-triggers with weak signals).

Chorus/Mod Effects

The Chorus/Mod Effects row in the RPx400 is a multi-function module allowing you to select effects such as; Chorus, Flanger, Triggered Flanger, Phaser, Triggered Phaser, Tremolo, Panner, Vibrato, Rotary Speaker, YaYa™, AutoYa™, SynthTalk™, Envelope Filter (auto wah), Detune, Pitch Shift, and Whammy™ effects. When the Effects row is selected, the Number 1 Knob is used to turn the Effect module (EFFECT OF), and select the type of Modulation Effect to be used. After selecting the type of effect in this module, the Number 2-5 Knobs can then be used to adjust the individual Parameters associated with the selected effect. The following describes each Effect and their Parameters in more detail:

Chorus

A Chorus adds a short delay to your signal. The delayed signal is modulated in and out of tune and then mixed back with the original signal to create a thicker sound.

Parameter 1 - The Number 2 Knob adjusts the rate (Speed) of the modulation. Ranges from 1 to 99.

Parameter 2 - The Number 3 Knob adjusts the intensity (Depth) of the modulation. Ranges from 1 to 99.

Mod Level - The Number 5 Knob controls the volume of the Chorus. Ranges from 0 to 99.

The Number 4 Knob has no function when the Chorus is selected.

Flange

A Flanger uses the same principle as a Chorus but uses a shorter delay time and adds regeneration (or repeats) to the modulating delay. This results in an exaggerated up and down sweeping motion to the effect.

Parameter 1 - The Number 2 Knob adjusts the rate (Speed) of the modulation. Ranges from 1 to 99.

Parameter 2 - The Number 3 Knob adjusts the intensity (Depth) of the Modulation. Ranges from 1 to 99.

Parameter 3 - The Number 4 Knob adjusts the amount of regeneration (repeats) added to the Flanger delay. Ranges from 1 to 99.

Mod Level - The Number 5 Knob controls the mix of wet and dry signal. Ranges from 0 (all dry) to 99 (all wet).

Triggered Flanger

A Triggered Flanger is the same sound as a regular Flanger but allows you to choose the starting point of the Flanger sweep. In a regular Flanger, the low frequency oscillator (LFO) is continually sweep-
Creating Presets

ing up and down. This means that when you begin to play, the flanger may be at the top, bottom, or any random point of the sweep. With a Triggered Flanger, every time the signal exceeds the Sensitivity level setting, the Flanger will begin at the point of the sweep that you designate with the value of the LFO Start Parameter.

Parameter 1 - The Number 2 Knob adjusts the rate (Speed) of the modulation. Ranges from 1 to 99.
Parameter 2 - The Number 3 Knob adjusts the strength the signal must be (Sensitivity) in order to trigger the Flanger. Ranges from 1 (requiring strong signals to trigger) to 99 (triggers with weak signals).
Parameter 3 - The Number 4 Knob selects the point at where the Flanger will begin it’s sweep (LFO Start). Ranges from 0 to 99.
Mod Level - The Number 5 Knob controls the mix of wet and dry signal. Ranges from 0 (all dry) to 99 (all wet).

Phaser

A Phaser splits the incoming signal, and then changes the phasing of the signal. This signal is then taken in and out of phase and mixed back in with the original signal. As the phasing changes, different frequencies get canceled resulting in a warm sort of twisting sound.

Parameter 1 - The Number 2 Knob adjusts the rate (Speed) of the modulating phase. Ranges from 1 to 99.
Parameter 2 - The Number 3 Knob adjusts the intensity (Depth) of the modulation. Ranges from 1 to 99.
Parameter 3 - The Number 4 Knob adjusts the amount of effected signal returned to the input of the Phaser (Regeneration). Ranges from 1 to 99.
Mod Level - The Number 5 Knob controls the mix of wet and dry signal. Ranges from 0 (all dry) to 99 (all wet).

Triggered Phaser

A Triggered Phaser is the same sound as a regular Phaser but allows you to choose the starting point of the Phaser sweep. In a regular Phaser, the low frequency oscillator (LFO) is continually changing the phase of the signal. This means that when you begin to play, the phaser may be at the any random point of the phase. With a Triggered Phaser, every time the signal exceeds the Sensitivity level setting, the Phaser will begin at the point of phasing that you designate with the value of the LFO Start Parameter.

Parameter 1 - The Number 2 Knob adjusts the rate (Speed) of the modulating phase. Ranges from 1 to 99.
Parameter 2 - The Number 3 Knob adjusts the strength the signal must be (Sensitivity) in order to trigger the Phaser. Ranges from 1 (requiring strong signals to trigger) to 99 (triggers with weak signals).
Parameter 3 - The Number 4 Knob selects the point at where the Phaser will begin it’s sweep (LFO Start). Ranges from 0 to 99.
Mod Level - The Number 5 Knob controls the mix of wet and dry signal. Ranges from 0 (all dry) to 99 (all wet).

Tremolo

A Tremolo effect modulates the volume of the signal at an even rate.

Parameter 1 - The Number 2 Knob adjusts the rate (Speed) at which the volume modulates. Ranges from 1 to 99.
Parameter 2 - The Number 3 Knob adjusts the intensity (Depth) of the modulating volume. Ranges from 0 to 99.
The Number 4 and 5 knobs have no function when the Tremolo is selected.

**Panner**
An Auto Panner modulates the sound from left to right at an even rate.
Parameter 1 - The Number 2 Knob adjusts the rate (Speed) at which the signal pans from side to side. Ranges from 1 to 99.
Parameter 2 - The Number 3 Knob adjusts the intensity (Depth) of the changing pan. Ranges from 0 to 99.
The Number 4 and 5 knobs have no function when the Panner is selected.

**Vibrato**
A Vibrato effect modulates the pitch of the incoming signal at an even rate.
Parameter 1 - The Number 2 Knob adjusts the rate (Speed) at which the pitch modulates. Ranges from 1 to 99.
Parameter 2 - The Number 3 Knob adjusts the intensity (Depth) of the modulating pitch. Ranges from 1 to 99.
The Number 4 and 5 knobs have no function when the Vibrato is selected.

**Rotary Speaker**
Rotary Speaker is an emulation of a device that included a spinning horn and rotor (woofer). The rotation of these two speakers produced an interesting combination of the sound panning from side to side, as well as a slight pitch change due to speed of the sound coming towards, and then going away from the listener.
Parameter 1 - The Number 2 Knob adjusts the rate (Speed) of the spinning speakers. Ranges from 0 to 99.
Parameter 2 - The Number 3 Knob controls the intensity of the Effect. Ranges from 0 to 99.
Parameter 3 - The Number 4 Knob controls the doppler effect which is the ratio between the horn and the rotor positions. Ranges from 1 to 99.
Mod Level - The Number 5 Knob controls the mix of wet and dry signal. Ranges from 0 (all dry) to 99 (all wet).

**YaYa™**
The YaYa™ is an effect exclusive to DigiTech products. The YaYa™ is controlled by the Expression Pedal and combines the characteristics of a wah and a flanger together providing a unique talk box type of effect. As the Expression Pedal is rocked back and forth, the guitar appears to say “Yah.” The YaYa™ effect must be linked to the Expression Pedal in order to function. See page 18 for more information on linking the Expression Pedal.
Parameter 1 - The Number 2 Knob adjusts the Pedal.
Parameter 2 - The Number 3 Knob adjusts the intensity of the YaYa™ effect. Ranges from 1 to 99.
Parameter 3 - The Number 4 Knob adjusts the throaty quality of the YaYa™ effect. Ranges from 1 to 50.
Mod Level - The Number 5 Knob controls the mix of wet and dry signal. Ranges from 0 (all dry) to 99 (all wet).

**AutoYa™**
Like the YaYa™, an AutoYa™ combines the characteristics of a Wah and a Flanger together creating an almost human vowel sound as if the guitar were saying “Yah.” The AutoYa™ automatically provides this animation by modulating the sound at an even rate.
Parameter 1 - The Number 2 Knob adjusts the rate (Speed) of the modulation. Ranges from 1 to 99.
Creating Presets

Parameter 2 - The Number 3 Knob adjusts the intensity of the AutoYa™ effect. Ranges from 1 to 99.
Parameter 3 - The Number 4 Knob adjusts the throaty quality of the AutoYa™ effect. Ranges from 1 to 50.
Mod Level - The Number 5 Knob controls the mix of wet and dry signal. Ranges from 0 (all dry) to 99 (all wet).

SynthTalk™
SynthTalk™ is another effect exclusive to DigiTech. It makes your guitar seem to speak based upon the dynamics of your playing style.
Parameter 1 - The Number 2 Knob adjusts the Attack of the synthesized voice. Ranges from 1 to 99.
Parameter 2 - The Number 3 Knob adjusts the Release of the synthesized voice. Ranges from 1 to 99.
Parameter 3 - The Number 4 Knob changes the characteristics of the various synth voices. Ranges from 0 to 99.
Mod Level - The Number 5 Knob adjusts the sensitivity or the input signal required to trigger the SynthTalk™ effect. Ranges from 0 to 99.

Envelope Filter
The Envelope Filter is an automatic Wah effect that alters your sound based upon how hard the strings are struck.
Parameter 1 - The Number 2 Knob adjusts amount of Wah sweep once the Wah is triggered. Ranges from 1 to 99.
Parameter 2 - The Number 3 Knob adjusts the sensitivity or the input signal required to trigger the Wah effect. Ranges from 1 to 99.
Mod Level - The Number 5 Knob controls the mix of wet and dry signal. Ranges from 0 (all dry) to 99 (all wet).
The Number 4 Knob has no function when the Envelope Filter is selected.

Detune
A Detuner will make a copy of your incoming signal, take the copied signal slightly out of tune from the original, and mix the two signals together. The result is a doubling type of effect as if two guitars were playing the same part together.
Parameter 1 - The Number 2 Knob adjusts the amount of pitch difference applied to the copied signal. Ranges from -18 to 18.
Mod Level - The Number 5 Knob controls the volume of the detuned note. Ranges from 0 to 99.
The Number 3 and 4 knobs have no function when the Detune effect is selected.

Pitch Shift
A Pitch Shifter copies the incoming signal, then shifts the pitch of the copied note to a different note. The shifted note is then mixed back with the original signal sounding as if two guitars were playing in harmony.
Parameter 1 - The Number 2 Knob selects the interval of the shifted pitch. Ranges from -12 (12 semitones below) to 24 (24 semitones above).
Mod Level - The Number 5 Knob controls the volume of the shifted pitch. Ranges from 0 to 99.
The Number 3 and 4 knobs have no function when the Pitch Shift effect is selected.
Whammy™

Whammy™ is an effect that uses an Expression Pedal to bend the pitch of the incoming signal, or add a bendable harmony with the original signal. As the Pedal is moved, the note will bend either up or down. When Whammy™ is selected, it is automatically placed before the Amp Modeling as shown in the block diagram (at the beginning of the Effects section). The Whammy™ effect must be linked to the Expression Pedal in order to function. See page 18 for more information on linking the Expression Pedal.

Parameter 1 - The Number 2 Knob selects the interval and direction of the pitch bend. Choices are as follows:

<table>
<thead>
<tr>
<th>Whammy (no Dry Signal)</th>
<th>Harmony Bends (Dry Signal Added)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1OCTUP (1 octave above)</td>
<td>M3: MA3 (a minor third to a Major third)</td>
</tr>
<tr>
<td>2OCTUP (2 octaves above)</td>
<td>2N3MA3 (a second above to a Major third above)</td>
</tr>
<tr>
<td>2N3DN (a second below)</td>
<td>3R04TH (a third above to a fourth above)</td>
</tr>
<tr>
<td>REV2ND (a second below reversed pedal action)</td>
<td>4TH5TH (a fourth above to a fifth above)</td>
</tr>
<tr>
<td>4THDN (a fourth below)</td>
<td>5THOCT (a fifth above to an octave above)</td>
</tr>
<tr>
<td>1OCTN (an octave below)</td>
<td>HOCTUP (one octave above)</td>
</tr>
<tr>
<td>2OCTN (2 octaves below)</td>
<td>HOCTDN (one octave down)</td>
</tr>
<tr>
<td>DIVBOM (Dive Bomb)</td>
<td></td>
</tr>
</tbody>
</table>

Mod Level - The Number 5 Knob adjusts the volume of the Whammy™. Ranges from 0 to 99. The Number 3 and 4 knobs have no function when the Whammy™ is selected.

Delay

Delay is an effect that will record a portion of the incoming signal, and then play it back a short time later. The recording can repeat just once, several times, or infinitely (which turns off the input to the Delay and allows you to play over the top of a passage in the Delay loop).

Delay On/Off - The Number 1 Knob turns the Delay on (On) and off (OF).

Delay Type - The Number 2 Knob selects one of the 3 different types of Delay. Values include: DIGITAL (Digital Delay), ANALOG (Analog Delay), P PONG (Ping Pong Delay).

Delay Time - The Number 3 Knob adjusts the amount of Delay time. Ranges from 10 MS through 990 MS (10 through 990 ms in 10 ms increments), and 10 SEC through 20 SEC (1 second through 2 seconds in 100 ms increments).

Feedback - The Number 4 Knob adjusts the number of times the delayed signal will repeat. Ranges from 1 to 99 and rhold (infinite repeat).

Delay Level - The Number 5 Knob adjusts the volume of the Delay signal. Ranges from 0 to 99.

Reverb

Reverb can give the listener a sense that the material is being performed in various acoustical environments. It can provide the tight acoustics of a small room, or the ambience of huge arena.

Reverb Type - The Number 1 Knob selects the Type of Reverb or acoustic environment. The RPx400 provides your choice of ten different environments including:

| REV 0F = Reverb Off                         | PLATE = Plate                                   |
| STUDIO = Studio                             | HALL = Hall                                     |
| ROOM = Wood Room                            | AMPTHE = Amplitheater                          |
| CLUB = Club                                 | CHURCH = Church                                 |
| GARAGE = Parking Garage                     | ARENA = Arena                                   |
| SPRING = Spring                             |                                                   |
Creating Presets

PreDelay - The Number 2 Knob adjusts the amount of time it takes for the initial sound to reach the first reflective surface in the simulated environment. Ranges from 0 to 15.

Decay - The Number 3 Knob adjusts the length of time the Reverb is audible. Ranges from 1 to 99.

Damping - The Number 4 Knob controls the amount of sound which is absorbed in the simulated environment. Ranges from 0 to 99.

Reverb Level - The Number 5 Knob adjusts the volume of the Reverb. Ranges from 0 to 99.

Expression Pedal

The Expression Pedal on the RPx400 can be assigned to control the RPx400’s Volume, Whammy™, Ya Ya™, or just about any other parameter in real time with your foot. When a parameter has been assigned to the Expression Pedal, a programmable minimum and maximum value can also be assigned.

The procedure for assigning a parameter to the Expression Pedal is as follows:

1. Press the Select button until the Expression row has been selected (indicated by the LED lighting on the Expression row).
2. Rotate the Number 1 Knob until the word PEDAL appears in the Display.
3. Rotate the Number 2 Knob until the desired Parameter appears in the Display.
4. Rotate the Number 3 Knob to select the minimum value the assigned parameter will reach with the Expression Pedal in the toe up position (not available when volume is the assigned parameter).
5. Rotate the Number 4 Knob to select the maximum value the assigned parameter will reach with the Expression Pedal in the toe down position (not available when volume is the assigned parameter).
6. Store your Expression Pedal assignment to your Preset. See page 9 for more information on the storing procedure.

Parameters that can be controlled by the Expression Pedal are as follows:

A GAIN (Amp Gain) - Expression Pedal controls the Amp Gain or amount of distortion for the selected Amp Type.

AMPLVL (Amp Level) - Expression Pedal controls the Volume of the selected Amp Type.

Modulation Effects Parameters

<table>
<thead>
<tr>
<th>Active Effect</th>
<th>Available Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chorus</td>
<td>SPEED (Speed), DEPTH (Depth)</td>
</tr>
<tr>
<td>Flanger</td>
<td>SPEED (Speed), DEPTH (Depth), REGEN (Regeneration)</td>
</tr>
<tr>
<td>Triggered Flanger</td>
<td>SPEED (Speed), SENSITV (Sensitivity), LFOSTR (LFO Start)</td>
</tr>
<tr>
<td>Phaser</td>
<td>SPEED (Speed), DEPTH (Depth), REGEN (Regeneration)</td>
</tr>
<tr>
<td>Triggered Phaser</td>
<td>SPEED (Speed), SENSITV (Sensitivity), LFOSTR (LFO Start)</td>
</tr>
<tr>
<td>Tremolo</td>
<td>SPEED (Speed), DEPTH (Depth)</td>
</tr>
<tr>
<td>Vibrato</td>
<td>SPEED (Speed), DEPTH (Depth)</td>
</tr>
<tr>
<td>Rotary Speaker</td>
<td>SPEED (Speed), DEPTH (Depth), DOPLER (Doppler)</td>
</tr>
<tr>
<td>Panner</td>
<td>SPEED (Speed), DEPTH (Depth)</td>
</tr>
<tr>
<td>YaYa™</td>
<td>PEDAL (Pedal), DEPTH (Depth), RANGE (Range)</td>
</tr>
<tr>
<td>Auto Ya™</td>
<td>SPEED (Speed), DEPTH (Depth), RANGE (Range)</td>
</tr>
<tr>
<td>SynthTalk</td>
<td>ATTACK (Attack), RELEASE (Release), VOX (Vox), SENSITV (Sensitivity)</td>
</tr>
<tr>
<td>Envelope Filter</td>
<td>AMOUNT (Amount), SENSITV (Sensitivity)</td>
</tr>
<tr>
<td>Detune</td>
<td>AMOUNT (Amount)</td>
</tr>
<tr>
<td>Pitch Shift</td>
<td>AMOUNT (Amount)</td>
</tr>
<tr>
<td>Whammy™</td>
<td>AMOUNT (Amount)</td>
</tr>
</tbody>
</table>

YaYa™ (YaYa™) - Expression Pedal acts as a Ya Ya™ Effect when YaYa™ is engaged.

Whammy™ (Whammy™) - Expression Pedal acts as a Whammy™ Pedal when Whammy™ is engaged.

EffLvl (Effect Level) - Expression Pedal controls the Mix Level of the selected Modulation Effect Type.
Creating Presets

FBACK (Feedback) - Expression Pedal controls the amount of Delay Feedback.
DLYLVL (Delay Level) - Expression Pedal controls the Mix Level of the selected Delay Type.
DECAY (Decay) - Expression Pedal controls the length of Reverbs Decay time.
REVLVL (Reverb Level) - Expression Pedal controls the Reverbs Mix Level.
VOLPRE (Volume Pre) - Expression Pedal controls the Volume after the Amp Modeling but before the Effects.
VOLPST (Volume Post) - Expression Pedal controls the Volume at the end of the Effects chain.

V-Switch
The RPx400's Expression Pedal includes DigiTech's exclusive V-Switch. The V-Switch allows the Expression Pedal assignment to be switched on the fly. Applying extra pressure to the toe of the Expression Pedal will engage the V-Switch and the function of the Expression Pedal will switch between the assigned parameter and Wah. The sensitivity or amount of pressure required to engage the V-Switch can be adjusted to suit your personal taste (or weight of your foot). See page 36 for the V-Switch Sensitivity adjustment procedure.

LFO
The RPx400 includes two assignable low frequency oscillators (LFO TR and LFO SQ) which can be assigned to any of the same parameters available for assignment to the Expression Pedal. A low frequency oscillator will automatically vary the value of the assigned parameter at a steady rate. A minimum and maximum value each LFO will reach may be also be assigned. For instance; if the Amp Gain was assigned to LFO TR, and the minimum value was set at 1 and the maximum value was set at 99, the RPx400 would automatically sweep the amount of distortion from a clean sound to a distorted sound. Individual LFO speeds are also available for assignment. In the previous example, the LFO speed would determine the length of time it took the LFO to sweep from the clean to the distorted sound. LFO TR oscillates using a triangle waveform and LFO SQ uses a square waveform. The procedure for assigning the LFOs in the RPx400 is as follows:
1. Press the Select button until the Expression row has been selected (indicated by the LED lighting on the Expression row).
2. Rotate the Number 1 Knob to select whether you want to assign LFO TR (LFO TR) or LFO SQ (LFO SQ).
3. Rotate the Number 2 Knob until the desired parameter appears in the display.
4. Rotate the Number 3 Knob to select the minimum value the assigned parameter will reach at the bottom turn around point for the LFO (not available when volume is the assigned parameter).
5. Rotate the Number 4 Knob to select the maximum value the assigned parameter will reach at the top turn around point for the LFO (not available when volume is the assigned parameter).
6. Rotate the Number 5 Knob to select the speed at which the LFO will oscillate from the minimum to the maximum value.
7. Store your LFO assignment to your Preset. See page 9 for more information on the storing procedure.
RPx400 Setups

Setups Introduction
The RPx400 is equipped with four inputs and four outputs that can be configured several different ways for both live and recording applications. These configurations are selected in the DRUMS/SETUP row of the editing matrix using the five editing knobs. Settings include whether the Mic or Line inputs are routed through the RPx400’s effects processing, which outputs have Speaker Compensation enabled, and which pair of outputs mic, line, and guitar processing are routed to. The USB 1-2 Source and USB 3-4 Source knobs are used for configuring how all inputs, guitar processing, and drum machine are routed via USB to the computer for recording applications.

Mic / Line Setups
The Mic and Line Setups are configurations for the mic and line inputs designed primarily for live performance applications. The RPx400 acts as a mixing device for mic and line sources, and can eliminate the need for a mixer when the RPx400’s outputs are to be plugged directly into a full-range powered speaker system. When enabled, these inputs can be routed around or through the RPx400’s effects processing and then mixed directly into the RPx400’s 1/4” and XLR outputs.

Both Mic and Line inputs have four settings that can be independently selected using the Mic and Line knobs in the DRUMS/SETUP row of the effect matrix. The configurations are as follows:

- **MICOFF / LINOFF** - Mic and Line inputs are disabled.
- **MICDRY / LINDRY** - Inputs routed directly to RPx400’s outputs, bypassing all effects processing.
- **MICRVB / LINRVB** - Inputs routed through delay and reverb effects of the current preset.
- **MICFX / LINEFX** - Inputs routed through all effects of current preset.

### Mic Routing

<table>
<thead>
<tr>
<th>Mic Input</th>
<th>Mic = MICFX</th>
<th>Mic = MICRY</th>
<th>Mic = MICRVB</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pickup</td>
<td>Wah</td>
<td>Comp</td>
<td>Noise Gate</td>
</tr>
<tr>
<td>Sim</td>
<td></td>
<td>Amp/Cabinet</td>
<td>Mod/Chorus</td>
</tr>
<tr>
<td>Wah</td>
<td></td>
<td>Eq</td>
<td>Delay</td>
</tr>
<tr>
<td>Comp</td>
<td></td>
<td>Reverb</td>
<td></td>
</tr>
</tbody>
</table>

- **XLR Left Output**
- **XLR Right Output**
- **1/4” Left Output**
- **1/4” Right Output**

### Line Input Routing

<table>
<thead>
<tr>
<th>Line Left</th>
<th>Line = LINEFX</th>
<th>Line = LINEY</th>
<th>Line = LINRY</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pickup</td>
<td>Wah</td>
<td>Comp</td>
<td>Noise Gate</td>
</tr>
<tr>
<td>Sim</td>
<td>Comp</td>
<td>Amp/Cabinet</td>
<td>Mod/Chorus</td>
</tr>
<tr>
<td>Wah</td>
<td></td>
<td>Eq</td>
<td>Delay</td>
</tr>
<tr>
<td>Comp</td>
<td></td>
<td>Reverb</td>
<td></td>
</tr>
</tbody>
</table>

- **XLR Left Output**
- **XLR Right Output**
- **1/4” Left Output**
- **1/4” Right Output**
Speaker Compensation and Output Modes

The RPx400 features both 1/4" and XLR outputs on the rear panel. These jacks let you simultaneously connect the RPx400 to an amplifier/speaker system on stage via the 1/4" outputs and connect directly to your PA system via the XLR outputs. The RPx400 incorporates Speaker Compensation filtering that can be turned on or off independently for each output pair depending on your application needs. The six output modes for the RPx400 are as follows:

**SC OFF** - All input sources (guitar, mic, line, drums, and recorder playback) are routed to both output pairs. Speaker Compensation is turned off.

**SC XLR** - All input sources are routed to both output pairs. Speaker Compensation is turned on in XLR outputs only.

**SC 1/4** - All input sources are routed to both output pairs. Speaker Compensation is turned on in 1/4" outputs only.

**SC ALL** - Stereo guitar processing, mic, and line sources out both output pairs. Speaker Compensation is turned on in both 1/4" and XLR outputs.
The **SPLIT1** and **SPLIT2** Output Modes are designed for when you want to keep the guitar processing isolated from mic, line, drums, and audio playback during live performance. The **SPLIT1** Output mode routes guitar signal to the 1/4” outputs while the mic, line input sources, drums, and audio playback from the computer are routed out the XLR outputs. **SPLIT2** is the same as **SPLIT1** but the guitar signal with Speaker Compensation is also routed out the XLR outputs.

**SPLIT1** - Stereo guitar processing is routed to the 1/4” outputs without Speaker Compensation. Audio playback from the computer, mic, and line sources are routed to the XLR outputs.

**SPLIT2** - Stereo guitar processing is routed to the 1/4” outputs without Speaker Compensation. Stereo guitar processing, audio playback from the computer, mic, and line sources are routed to the XLR outputs with Speaker Compensation.

**NOTE:** Speaker Compensation may affect Mic and Line signals depending on which Output Mode is selected.
The RPx400 and Recording

Recording Introduction
The RPx400's USB connection provides 4 channels of audio streaming into the computer and 2 channels of playback from the computer simultaneously. Recording has never been easier thanks to the hands-free tracking environment that the RPx400 and Pro Tracks software provide. The RPx400's footswitches and Pro Tracks software work seamlessly together to automatically arm, record, play, and delete tracks on the fly without ever having to take your hands off the guitar. Multiple recording configurations can be selected to best optimize your recording needs. These configurations are accessed via the RPx400's effect's matrix in the DRUMS/SETUP row.

To begin recording you must first install the proper USB drivers and Pro Tracks recording software onto your Windows compatible PC. The USB drivers are found on the X-Edit Software CD that came packaged with the RPx400 and the Pro Tracks recording software CD is found in the Pro Tracks box. Please review the Pro Tracks documentation to ensure your computer system meets the necessary requirements prior to installation. Once installed and configured, the RPx400 can then control Pro Tracks and its recording functions.

Installing RPx400 USB Drivers
The RPx400 USB drivers must first be installed before using either the X-Edit editor/librarian or Pro Tracks recording software. These drivers are found on the X-Edit Software CD that came packaged with the RPx400. To install X-Edit and the USB drivers, follow these steps:

Windows XP Users
1. Start your computer.
2. Insert the X-Edit CD into your CD drive. The installation menu should automatically appear (if installation does not start automatically, go to Start>Run, click on Browse button, find and double-click instmenu.exe on the X-Edit CD).
3. First you must install the USB drivers needed by your computer system in order to use USB with X-Edit and Pro Tracks. This procedure is the same when you upgrade your RPx400’s device drivers in the future. Plug in the USB from your computer to the RPx400 using the included USB cable. You will see multiple messages pop up from the task bar indicating that your computer has found a USB device. There are multiple messages because there are four USB devices in the RPx400, two MIDI devices and two audio devices.
4. Select USB Audio MIDI Drivers from the menu that appears. The RPx400 USB Driver Installer window will appear.

NOTE: If you don’t have the USB connected you will see the message prompting your to have the device connected. Cancel the installation, connect the RPx400’s USB to the computer and launch the installer again.

5. Once the RPx400 is properly connected, the Hardware Installation windows will appear. Click the Continue Anyway button on each of the four windows that appear.
6. Click the Finish button. The RPx400’s USB driver installation is now complete. At this point you are ready to use the RPx400 to record with Pro Tracks.
The RPx400 and Recording

Windows 2000 Users

1. Start your computer.
2. Insert the X-Edit CD into your CD drive. The installation menu should automatically appear (if installation does not start automatically, go to Start>Run, click on Browse button, find and double-click instmenu.exe on the X-Edit CD).
3. First you must install the USB drivers needed by your computer system in order to use USB with X-Edit and Pro Tracks. Make sure you do NOT have the RPx400 USB plugged into your computer.
4. Select USB Audio MIDI Drivers from the menu that appears. The RPx400 USB Drivers Installer window will appear. Click the Next button.
5. The Digital Signature Not Found window will appear. Click the Yes button.
6. The Digital Signature Not Found window will appear again. Click the Yes button.
7. The RPx400 USB Driver Installer window will appear. Click the Finish button.
8. Plug the RPx400’s USB into your computer. You will see multiple messages pop up indicating that your computer has found a USB device. There are multiple messages because there are four USB devices in the RPx400, two MIDI devices and two audio devices. The following is a guide through these pop up messages.
9. Once the RPx400’s USB is connected, the Digital Signature Not Found window will appear. Click the Yes button.
10. The Found New Hardware Wizard window will appear. Click the Finish button.
11. The System Settings Change window will appear. Click the No button.
12. Another Digital Signature Not Found window will appear again. Click the Yes button.
13. Another Found New Hardware Wizard window will appear. Click the Finish button.
14. Another System Settings Change window will appear. Click the No button.
15. Another Digital Signature Not Found window will appear again. Click the Yes button.
16. Another Found New Hardware Wizard window will appear. Click the Finish button.
17. Another System Settings Change window will appear. Click the No button.
18. Another Found New Hardware Wizard window will appear. Click the Finish button.
19. Another System Settings Change window will appear. Click the Yes button. Your computer will restart.

You are now ready to record with Pro Tracks using your RPx400. To use the recording features of the RPx400, please read the Using Pro Tracks section of this User’s Guide

Installing X-Edit Editor Librarian

Once you have the USB drivers are installed you can then install the X-Edit Editor/Librarian software. To install X-Edit, follow these steps:
1. Return to the installer menu (from USB Driver Installation step 2) and select DigiTech X-Edit.
2. The installer will now check your computer for Microsoft .NET Framework. If it is not found, the .NET installer will be launched. Follow the instructions that appear.
3. When the .NET installer has completed, Welcome to the Installation Wizard for DigiTech X-Edit 1.0 appears. Click the Next button.
4. Fill in the customer information. Select Anyone who uses this computer to allow all users to use X-Edit. Select Only for me if you want to be the only user to use X-Edit on the computer. Click the Next button.
5. On the next screen, click the Install button.
6. When the installation is complete, click the Finish button.

You are now ready to begin using the X-Edit Editor/Librarian software with the RPx400.
Connecting the RPx400 to the Computer

The RPx400 comes equipped with a USB cable that is to be connected to your computer whenever you
will be recording or using the X-Edit Editor/Librarian. We recommend that you only use the USB cable
that is shipped with the RPx400 since it has been tested and approved for this specific use. To connect
the RPx400 to the computer, follow these steps:

1. Begin with the power disconnected from the RPx400.
2. Plug the small end of the USB cable in to the USB jack on the back of the RPx400.
3. Plug the large flat end of the USB cable into an available USB port on your computer.
4. Connect power to the RPx400.

RPx400 Recording Setup

The RPx400 has several different input / output configurations called Setups offering a wide variety of
recording possibilities. These are selected using the **USB 1-2 Source** and **USB 3-4 Source** knobs in
the RPx400’s effect matrix. For a given recording session, you may want to record guitar with effects, dry
guitar, vocal, line inputs, a combination of these, or even re-amp your dry guitar tracks back through the
RPx400. Up to 4 channels of audio can be sent simultaneously to the computer and the knobs in the
**SETUP** row select how and which audio signals are routed up the USB connection. Each USB Source
routes a pair of signals to the computer. The following sections outlines how these signals are routed:

**USB 1-2 Source**

**STEREO** - All input sources that are routed through the RPx400’s effects are sent up USB 1 and 2.
**MONO** - All input sources that are routed through the RPx400’s effects are summed to mono and sent up
USB 1. Nothing is sent up USB 2
**SUM+DG** - All input sources that are routed through the RPx400’s effects are summed to mono and sent up
USB 1. Dry guitar is sent up USB 2.
**SUMMIC** - All input sources that are routed through the RPx400’s effects are summed to mono and sent up
USB 1. Dry mic signal is sent up USB 2.
**DGTR+M** - Dry guitar signal is sent up USB 1. Dry mic signal is sent up USB 2.
**DRYLIN** - Dry Line Left signal is sent up USB 1 and Dry Line Right signal is sent up USB 2.
**DRYGTR** - Dry guitar signal is sent up USB 1. Nothing is sent up USB 2.
**DRYMIC** - Dry mic signal is sent up USB 1. Nothing is sent up USB 2.
**DRUMS** - RPx400 drum playback is sent up USB 1. Nothing is sent up USB 2.
**REAMP** - Playback from Pro Tracks is sent from the computer back through the RPx400’s effects process-
ing, and then sent back up USB 1 and 2 to be recorded. See Re-amping a Guitar Track on page 32 for more information on how to use this setting.

**USB 3-4 Source**

**USBOFF** - USB 3 and 4 are disabled.
**DGTR+M** - Dry guitar signal is sent up USB 3. Dry mic signal is sent up USB 4.
**DRYLIN** - Dry Line Left signal is sent up USB 3 and Dry Line Right signal is sent up USB 4.
**DRYGTR** - Dry guitar signal is sent up USB 3. Nothing is sent up USB 4.
**DRYMIC** - Dry mic signal is sent up USB 3. Nothing is sent up USB 4.
**DRUMS** - RPx400 drum playback is sent up USB 3. Nothing is sent up USB 4.

The following diagrams show how signals are routed through the RPx400’s effects and out the USB port
for recording purposes:
The RPx400 and Recording

Guitar Signal Routing
The guitar signal is routed from the input through the RPx400s effects processing and then to the pairs of outputs. The signal sent up USB can be tapped off either at the input (USB Send Path A), or at the end of the effects chain (USB Send Path C). Signals recorded from USB Send Path A can be played back later through the RPx400 for re-amping. See Re-Ampling a Guitar Track on page 32 for more information on how this feature works.

Guitar USB Source Mapping
The guitar signal has two paths in which it can travel up the USB port to the computer. Path A taps the guitar signal off right at the input and sends unprocessed signal up to the USB port. Path C taps the guitar signal at the output of the RPx400 and can include any effects processing that may be used. Below is a matrix to show where the signal is tapped based on how the Mic, USB 1-2 Source, and USB 3-4 Source settings are configured.

Mic Signal Routing
The mic signal can be routed in different ways through the RPx400. MICOFF disables the mic input from being heard but dry mic signal can still be recorded. MICDRY routes the mic signal around the RPx400’s effects processing and mixes it in at the outputs. MICRVB routes the mic signal only through the RPx400 Delay and Reverb modules. MICFX routes the mic signal through all of the RPx400’s effects.
Mic USB Source Mapping

The mic signal, as can be seen in the previous Mic Signal Routing diagram, has two paths in which it can travel up the USB port to the computer. Path E taps the mic signal off right at the mic input and sends unprocessed signal up to the USB port. Path C taps the signal at the output of the RPx400 and can include any effects processing that may be used. Below is a matrix to show where the signal is tapped based on how the Mic, USB 1-2 Source, and USB 3-4 Source settings are configured.

Line Signal Routing

The line signals, like the mic signal, can be routed in different ways through the RPx400. LINOFF disables the line inputs from being heard but dry line signal can still be recorded. LINDRY routes the left and right line signals around the RPx400’s effects processing and mixes them in at the left and right outputs respectively. LINRVB routes the line signals only through the RPx400 Delay and Reverb modules. LINEFX sums the left and right line input signals together and then routes this signal through all of the RPx400’s effects.

Line USB Source Mapping

The line input signals, as can be seen in the previous Line Signal Routing diagram, has two paths in which they can travel up the USB port to the computer. Path A taps the line input signals off right at the line input and sends unprocessed signal up to the USB port. Path B taps these signals at the output of the RPx400 and can include any effects processing that may be used. Below is a matrix to show where the signal is tapped based on how the Line, USB 1-2 Source, and USB 3-4 Source settings are configured.
The RPx400 and Recording

Using Pro Tracks
When Pro Tracks is first launched after installation, you will have to configure the MIDI device and Audio settings to recognize the RPx400 as the hardware you want to use. These procedures must be followed to ensure you will be able to record audio through all of the RPx400's inputs and to enable the hands-free recording capabilities the RPx400 offers.

NOTE: Read the Software Installation sheet that came packaged with the RPx400 for instructions on installing USB drivers before connecting the RPx400 to the USB port on your computer and using Pro Tracks.

Installing Pro Tracks Software
Pro Tracks software must be installed on your computer in order to use the recording capabilities of the RPx400. To install Pro Tracks, please consult the installation instructions provided with the Pro Tracks installation CD.

Setting Up the RPx400 MIDI Device
The RPx400 uses MIDI commands to communicate with Pro Tracks. These commands are used to determine which USB 1-2 Source and USB 3-4 Source settings have been selected so that Pro Tracks can function properly when using the RPx400's hands-free recording features. To configure Pro Tracks' MIDI settings for use with the RPx400 follow the steps outlined below:

1. Start Pro Tracks application on your computer.
2. If the Tip of the Day window appears, click the Close button.
3. If no previous MIDI outputs have been selected, the No MIDI Outputs Selected window will appear. Click the Choose MIDI Outputs Now button. The MIDI Devices window will open.
4. Under both Input and Output Selections, choose RPx400 USB MIDI. Do not select DigiTech USB X-Edit or any other available selections. Click the Move Selected Devices to Top button.
5. Click the OK button and the window will close.
6. If the Quick Start window appears, click the Close button.

Setting up the RPx400 for Hands-Free Recording

1. From the Pro Tracks menu bar, select Options>Control Surfaces. The Control Surfaces window will appear.
2. Click the + button to add a new control surface. The Control Surface Settings window will open.
3. In the Control Surface pull-down menu, select DigiTech RPx. Verify that the Input and Output port settings still have RPx400 USB MIDI selected. If they do not, do this now.
4. Click the OK button. DigiTech RPx should now be displayed as the Connected Surface in the Control Surfaces Window.
5. Click the Close button.

Pro Tracks can now respond to the RPx400 for automated recording functions.

Setting up Pro Tracks for RPx400 Audio

1. From the Pro Tracks menu bar, select Options>Audio. The Audio Options window will appear. Click the Drivers tab.
2. Under the Input Drivers settings, select DigiTech USB 1-2 In/Out and DigiTech USB 3-4 In Only and deselect all other options.
The RPx400 and Recording

3. Under the **Output Drivers** settings, select **DigiTech USB 1-2 In/Out** and deselect all other options.
4. Click the **OK** button.
5. Click the **OK** button when the window stating changes will be saved upon re-start appears.
6. Close the Pro Tracks application. When you are prompted to save changed, click **No**.
7. Re-start the Pro Tracks application again.
8. Close the **Tip of the Day** and **Quick Start** windows if they appear.
9. From the Pro Tracks menu bar, select **Options>Audio**.
10. Verify that the Playback and Record Timing Master settings have **DigiTech USB 1-2 In/Out** selected. If not, select these now.
11. Click the **Wave Profiler** button at the bottom.
12. Click the **Yes** button to continue performing the tests.
13. When the profiling operation is successfully completed, click the **OK** button.
14. Click the **OK** button to close the **Audio Options** window if it is still open.

You are now ready to use the RPx400 with Pro Tracks recording software.

**CAUTION:** Do not disconnect power or disconnect the USB cable from the RPx400 or the computer while the Pro Tracks software is running. Doing so can result in unpredictable behavior from your computer’s operating system.

**Using the RPx400’s Footswitches for Recording**

The RPx400’s footswitches are capable of controlling the Pro Tracks™ recording software, creating a hands-free recording interface. To do this, the RPx400 must be connected to the computer via the included USB cable and the Pro Tracks application must be installed and open.

**Recording a Track or Tracks**

To begin recording a track using the footswitches, follow these steps:

1. Start the Pro Tracks application.
2. From the Pro Tracks menu bar, select **File>New**. The **New Project File** window will appear.
3. From the **New Project File** window, select **Normal - Hands-Free Session**.
4. Put the RPx400 footswitches in Recorder mode by pressing and holding the **UP** and **AMP A/B** buttons.
The RPx400 and Recording

footswitches simultaneously until the display reads **REC F5**.
5. From the preset display, press and hold the **SELECT** button to enter the **SETUP** row in the RPx400's matrix. Otherwise, press the **SELECT** button several times until the setup row is selected.
6. Select the sources to record using the **USB 1-2 Source** knob (additional sources can be selected using the **USB 3-4 Source** knob).
7. Press the **RECORD** footswitch. The RPx400's display reads **REC**. A track or tracks are automatically inserted in the current session of the Pro Tracks software and recording on these tracks begins.
8. To stop recording, press the **STOP/UNDO** footswitch. The RPx400's display reads **STOP** and Pro Tracks stops recording. The wave data for the track(s) can now be viewed on your computer monitor.

Playing Back a Recorded Track

After a track or tracks have been recorded, playing them back is easy. If you want to start playback at the beginning of a track or song but are someplace other than the end of the song, follow these steps:

1. Press the **STOP/UNDO** footswitch once. The RPx400 display will read **REWIND**. Pro Tracks will rewind to the beginning of the current song.
2. Press the **PLAY** footswitch. The recorded track(s) will begin playing back.

Recording Multiple Tracks

After tracks have been recorded, you may want to record other tracks that play along with them. To record a new track or tracks with previously recorded tracks, follow these steps:

1. From the preset display, press and hold the **SELECT** button to enter the **SETUP** row in the RPx400's matrix.
2. Select the sources to record using the **USB 1-2 Source** knob (additional sources can be selected using the **USB 3-4 Source** knob).
3. Press the **STOP/UNDO** footswitch twice. This will rewind to the beginning of the current song.
4. Press the **RECORD** footswitch. The RPx400's display reads **REC**. A track or tracks are automatically inserted in the current session of the Pro Tracks software and recording on these tracks begins.
5. To stop recording, press the **STOP/UNDO** footswitch.

Using the **UNDO** Footswitch to Erase a Track

You can undo the last take or previous tracks using the RPx400's footswitches. To undo tracks, follow these steps:

1. Press and hold the **STOP/UNDO** footswitch. The RPx400's display reads **UNDO**, indicating the last recorded track(s) are being deleted.

Re-Amping a Guitar Track

Using one of the Dry Guitar configurations for recording gives you the opportunity of playing that dry take back into the RPx400 for re-processing. The advantages of having this feature are you can experiment playing the dry guitar take back through different amp models, effects, or entirely new presets once you have your other tracks recorded. This helps when trying to fit a guitar sound into a mix after the song is assembled rather than relying on tricky EQ settings that can tarnish the tone you originally recorded.
The RPx400 and Recording

To re-amp a track back through the RPx400, follow these steps:
1. Put the RPx400 footswitches in Recorder mode by pressing and holding the UP and AMP A/B footswitches until the display reads REC FS.
2. From the Pro Tracks menu bar, select File>New. The New Project File window will open.
3. Select the Normal-Hands Free Session project template.
4. Select the SETUP row in the RPx400’s matrix.
5. Use the USB 1-2 Source knob to select DRyGTR and USB3-4 Source to OFF.
6. Press the RECORD footswitch. The RPx400’s display reads RECORD. A track is automatically inserted in the current session of the Pro Tracks software and recording on this track begins.
7. To stop recording, press the STOP/UNDO footswitch. The RPx400’s display reads STOP and recording will stop. Press Stop again to rewind to the beginning of the track.
8. In the Out box of the track you just recorded, select B(Digitech USB 1-2 In/Out).

9. In the tool bar press the Console View button to see the mixing console.


11. Select the SETUP row again and use the USB 1-2 Source knob to select REAMP. This configures the recording software to playback audio through the RPx400’s effects processing.
12. Press the PLAY footswitch. Put the footswitches back to Performance mode by pressing and holding the UP and AMP A/B footswitches simultaneously until the display reads UP DOWN. You can now audition presets until you find one you like. Once you have done so, return to Recorder footswitch mode.
13. Press the STOP/UNDO footswitch twice to rewind to the beginning of the track.
14. Press the RECORD footswitch and the recorder will now insert and record a stereo track of processed guitar.
15. To stop recording, press the STOP/UNDO footswitch.
The RPx400 and Recording

RPx400 Drums and MIDI

The RPx400’s Drum machine samples are mapped so that they may be triggered by MIDI notes played from Pro Tracks. Each of the drum patterns programmed in the RPx400 has been programmed as a MIDI track in the Pro Tracks project file library.

Note mapping for each of the RPx400’s drum samples is as follows:

<table>
<thead>
<tr>
<th>MIDI Note</th>
<th>Sample</th>
</tr>
</thead>
<tbody>
<tr>
<td>36/C3</td>
<td>Kick</td>
</tr>
<tr>
<td>38/D3</td>
<td>Snare</td>
</tr>
<tr>
<td>42/F#3</td>
<td>Closed High Hat</td>
</tr>
<tr>
<td>46/Bb3</td>
<td>Open High Hat</td>
</tr>
</tbody>
</table>

Recording the RPx400 Drums

The RPx400’s drum machine can be recorded using Pro Tracks. Each of the RPx400 drum patterns have been saved as pattern template files which can be selected from the Pro Tracks project file library for playback control of the RPx400’s drum samples. To record the RPx400 drums using the pattern templates provided in Pro Tracks, follow these steps:

1. From the Pro Tracks menu bar, select **File>New**. The **New Project File** window will appear.
2. Select one of the DigiTech RPx400 drum templates and click the **OK** button. This will open up a new recording session.
3. On the RPx400, use the either **USB 1-2 Source** or **USB 3-4 Source** knobs to select **DRUMS**.
4. Press the **RECORD** footswitch. The RPx400’s display reads **RECORD**. A new track is automatically inserted in the current session of the Pro Tracks software and recording on these tracks begins.
5. To stop recording, press the **STOP/UNDO** footswitch.

You can use MIDI drum files for playing the RPx400 drum samples if you like as long as the events are mapped to the MIDI notes shown above. The drum samples of the RPx400 only respond to MIDI messages transmitted on MIDI channel 10, which is the default channel for General MIDI drums.

Playback Mix

The **PLAYBACK MIX** knob is an easy way to balance the RPx400’s processing with playback from the Pro Tracks software using a single control. This function is only available when the RPx400 is connected to the computer via USB and Pro Tracks is up and running. To change the RPx400/Playback mix, follow these steps:

1. Start playback of a session from Pro Tracks.
2. Turn the playback mix knob to balance the level of RPx400 guitar processing and playback level. When the display reads **USBMIX 0** indicates that only RPx400 signals will be heard. Rotating this knob clockwise, you will begin to hear the playback level increase. **USBRPX 50** indicates the RPx400/computer playback mix is a 50/50 mix of both signals. Continuing to rotate the knob clockwise will decrease RPx400 level. **RPxMIX 0** indicates that only playback from the computer will be heard.
The RPx400 and Recording

USB 1-2 Level / USB 3-4 Level

The **USB 1-2 LEVEL** and **USB 3-4 LEVEL** knobs are used for boosting or cutting the amount of signal sent out the USB port to the computer. These controls are to be used if the signal level of the input source (mic, line, guitar) isn't optimized into your recording software (consult the Pro Tracks User's Guide for information on proper recording levels). If the signal is too hot to Pro Tracks, use these controls to decrease the level. The USB 1-2 Level and USB 3-4 Level knobs control the level for each USB pair of outputs so for example, if **SUMMIC** is the selected USB 1-2 Source, increasing the level for the mic 6dB going up USB 2 will also increase the summed signal by 6dB going up USB 1. To increase or decrease the level of audio going up to the computer, follow these steps.

1. Play/sing through the RPx400 and check the level of signal reaching the recording software (consult the Pro Tracks User’s Guide for information on how to view recording signal levels).
2. Use which ever USB Level knob to boost or cut the signal level going to the recording software. The boost/cut range are -6db (USB1-2 -6) to +24dB (USB1-2 24).

Using the RPxFC for Recorder Functions

The RPx400 is equipped with a footswitch jack that lets you connect an optional RPxFC for controlling the RPx400’s recorder. This 3-button footswitch features functions for **STOP/UNDO**, **RECORD**, and **PLAY**. The RPxFC is an ideal companion for recording as it lets you leave your RPx400 footswitches setup for changing presets and switching amp channels while the RPxFC is used specifically for controlling the Pro Tracks recording software. Use only a TRS stereo 1/4” cable when connecting the RPxFC to the RPx400.

The RPxFC functions are exactly the same as the RPx400 footswitches when it is in Recording mode. Refer to section **Using the RPx400’s Footswitches for Recording** for operating instructions.
Utilities

Factory Reset
This function resets the RPx400 to its original factory settings. This procedure erase all custom user presets, and recalibrate the Expression Pedal.

ATTENTION: Performing this function erases all user-programmed data. Be sure you want to erase the memory and start fresh before continuing with this procedure.

The procedure for performing a Factory Reset is as follows:
1. Disconnect the power supply from the RPx400.
2. Press and hold the Select button while re-connecting the power to the RPx400.
3. When the display reads \textit{RST} ? , release the Select button and press the Store button. The display reads \textit{RESET} indicating that the RPx400 has reset the original factory settings. At this point, the RPx400 automatically advances to the Expression Pedal calibration menu. Follow steps 4 through 7 of the Expression Pedal calibration section.

Expression Pedal Calibration
The Expression Pedal needs to be recalibrated after a factory reset. This function is automatically prompted after a factory reset. In the event the pedal’s calibration fails, or if the pedal does not function properly, it can be re-calibrated using the Pedal Calibration function. This does not erase the User Presets. The procedure for Calibrating the Expression Pedal is as follows:
1. Disconnect the PS0913B power supply from the power jack on the RPx400.
2. Press and hold the Down Footswitch while re-connecting the power.
3. Continue to hold the Down Footswitch until the display briefly reads \textit{calib} (calibration).
4. When the display reads \textit{TOE DN}, rock the Expression Pedal forward to the toe down position.
5. Press any footswitch. The display reads \textit{TOE UP}.
6. Rock the Expression Pedal back to the toe up position.
7. Press any footswitch. The display reads \textit{VSWTCH} indicating you have entered the V-Switch Sensitivity menu.
8. If you do not want to adjust the V-Switch sensitivity, press any footswitch to return to Performance Mode.

Note: If error displays, an error has occurred and steps 4 through 8 should be repeated.

V-Switch Sensitivity
If you want to adjust the sensitivity setting of the V-Switch, follow steps 1 through 7 of Calibrating the Expression Pedal and then follow the steps listed below:
1. When the display reads \textit{VSWTCH}, rock the Expression Pedal forward (toe down) and apply extra pressure on the toe of the pedal until the display reads \textit{DONE}.
2. When display alternates between \textit{DONE} (with the V-Switch sensitivity value in the numeric Display) and \textit{VSWTCHON} (or \textit{VSWTCHO} depending on whether the V-Switch is on or off), you can audition the V-Switch sensitivity by applying pressure to the toe of the Expression Pedal.
3. Rotate the Number 5 Knob to change the value of the V-Switch sensitivity. You can audition the new value by applying pressure to the toe of the Expression Pedal.
4. Once the sensitivity value is selected, press any footswitch. The RPx400 returns to Performance Mode and your settings are automatically saved.
Trouble Shooting Guide

Audio playback from Pro Tracks has pops and clicks.

- Try the Wave Profiler under Options->Audio. This seems to fix most problems. Otherwise, try using MME drivers in the Options->Audio->Advanced, Driver Mode selection. These are the safest drivers but also have the most latency.
- Try increasing the latency slider in the audio settings.

Hands-Free recording on RPx 400 doesn't work or has stopped working.

- If it was working at one point but has stopped working, try exiting Pro Tracks and then restarting it (make sure to save your project).
- Cycle power to the RPx 400 before entering Pro Tracks or X-Edit.
- If it has never worked at all, there is a problem with USB MIDI The most probable causes are using incorrect or incorrectly installed drivers and/or .dll or a bad USB cable.
- See the section on driver installation.

I can't hear audio playback from Pro Tracks.

- If the ‘Reamp’ mode in the RPx 400 is active try switching to a different mode like ‘Stereo’.
- Make sure the faders in Pro Tracks are turned up.
- Check that the tracks you want to playback are un-muted.
- Go to Options->Audio->Drivers and under output drivers, select ‘DigiTech USB 1-2 In/Out’ and de-select everything else.
- See the section on driver installation.

My RPx 400 doesn't record to Pro Tracks.

- Go to Options->Audio->Drivers and under input drivers, select ‘DigiTech USB 1-2 In/Out’ and ‘DigiTech USB 3-4 In Only’ De-select everything else.
- Make sure the proper drivers are installed.
- See the section on driver installation.
- For an initial track, make sure ‘Reamp’ mode in the RPx 400 is not used.

I can't get Re-amping to work.

- See the Re-Amping a Guitar Track section of this user's guide.

Pro Tracks intermittently locks up.

- Close any other open programs besides Pro Tracks check "task manager" to make sure there are no hidden pro-
- grams running.
- Try reducing the number of plug-ins and soft-synths.
- Increase the amount of memory in your system.
- Get a faster hard drive.
- Put your audio data on a different hard drive from your OS and applications.
- Get a faster computer.
- Please refer to the system requirements section.

Where did my wave files go?

- Wave files all get saved to the folder specified in Options->Global, Audio Data.

My waves are low/too high in level.

- The recording signal level can be boosted or reduced using the USB1-2 and USB3-4 level controls.

Pro Tracks playback is louder than my guitar.

- You can adjust the mix of playback versus guitar by using the Playback mix knob.
Trouble Shooting

I get audio dropout while I'm recording.
- Try increasing the latency slider in the Audio settings.
- Try reducing the number of tracks in your project (mute won't help, you either have to "archive" the tracks, or delete them)
- Close any other open programs besides ProTracks check Windows Task Manager to make sure there are no hidden programs running.
- Try reducing the number of plug-ins and soft-synths.
- Increase the amount of memory in your system.
- Get a faster hard drive.
- Put your audio data on a different hard drive from your OS and applications.
- Get a faster computer.

When I launch X Edit, it can't find the RPx 400.
- Make sure your drivers are loaded correctly and that the USB cable is inserted securely.
- See the section on USB Driver installation.

I hear doubling of the playback.
- Input monitoring is probably active. Go to Options->Audio->Input Monitoring to disable.

Bass, Mid and Treble controls are not working.
- When USB is connected, the Bass, Mid and Treble controls function as Playback Mix, USB 1-2 Level, and USB 3-4 Level controls. The tone controls can still be accessed from the editing matrix or from X Edit.

My mic didn't record.
- Dry mic can only be recorded on a separate track, not as part of a mix. To record mic, go to the setup level of the matrix and select MIRCRO in USB1-2 Source or USB3-4 Source.
- Mic with reverb or effects can be recorded as a mix with guitar. The Mic setup must be set to either MIRCRO or MIEFX.

My drums didn't record.
- Drums can only be recorded on a separate track, not as part of a mix. To record drums, go to the setup level of the matrix and select DRUMS in USB1-2 Source or USB3-4 Source.

My line inputs didn't record.
- Dry line inputs can only be recorded on a separate track, not as part of a mix. To record line inputs, go to the setup level of the matrix and select DRYLIN in USB1-2 Source or USB3-4 Source.
- Line with reverb or effects can be recorded as a mix with guitar. The Line selector must be set to either LINRV or LINEFX.

I get dropout when I change presets during recording/playback.
- Don't change presets during recording/playback.

My mic/line inputs had dropout while I was recording.
- Changing presets while recording will cause dropout of mic and line audio to the computer.

Pro Tracks won't launch.
- This was probably caused by interrupting the USB connection while in a previous Pro Tracks session. You must reboot your system to fix this problem.

I don't hear playback from USB 3-4.
- Playback is only available on USB1-2. USB3-4 is used for additional track recording – like dry guitar, mic, drums, etc.
## Appendix

### CC Parameter List

<table>
<thead>
<tr>
<th>CC</th>
<th>Parameter</th>
<th>CC</th>
<th>Parameter</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>EXPRESSION PEDAL CONTROL</td>
<td>51</td>
<td>FX PARAM3</td>
</tr>
<tr>
<td>7</td>
<td>MASTER LEVEL</td>
<td>52</td>
<td>FX LEVEL</td>
</tr>
<tr>
<td>18</td>
<td>COMP ON/OFF</td>
<td>53</td>
<td>DLY ON/OFF</td>
</tr>
<tr>
<td>19</td>
<td>COMP ATTACK</td>
<td>54</td>
<td>DLY TYPE</td>
</tr>
<tr>
<td>20</td>
<td>COMP RATIO</td>
<td>55</td>
<td>DLY TIME</td>
</tr>
<tr>
<td>21</td>
<td>COMP THRESH</td>
<td>56</td>
<td>DLY FEEDBACK</td>
</tr>
<tr>
<td>22</td>
<td>COMP GAIN</td>
<td>57</td>
<td>DLY LEVEL</td>
</tr>
<tr>
<td>23</td>
<td>AMP CHANNEL</td>
<td>58</td>
<td>RVB ON/OFF</td>
</tr>
<tr>
<td>24</td>
<td>AMP A TYPE</td>
<td>59</td>
<td>RVB TYPE</td>
</tr>
<tr>
<td>25</td>
<td>AMP A GAIN</td>
<td>60</td>
<td>RVB PREDELAY</td>
</tr>
<tr>
<td>26</td>
<td>AMP A LEVEL</td>
<td>61</td>
<td>RVB DECAY</td>
</tr>
<tr>
<td>27</td>
<td>CAB A MIC</td>
<td>62</td>
<td>RVB DAMP</td>
</tr>
<tr>
<td>28</td>
<td>AMP B TYPE</td>
<td>63</td>
<td>RVB LEVEL</td>
</tr>
<tr>
<td>29</td>
<td>AMP B GAIN</td>
<td>75</td>
<td>MIC ROUTING</td>
</tr>
<tr>
<td>30</td>
<td>AMP B LEVEL</td>
<td>76</td>
<td>LINE ROUTING</td>
</tr>
<tr>
<td>31</td>
<td>CAB B MIC</td>
<td>77</td>
<td>USB1-2 SOURCE</td>
</tr>
<tr>
<td>32</td>
<td>EQ A ON/OFF</td>
<td>78</td>
<td>USB3-4 SOURCE</td>
</tr>
<tr>
<td>33</td>
<td>EQ A LOW</td>
<td>79</td>
<td>SPEAKER COMPENSATION</td>
</tr>
<tr>
<td>34</td>
<td>EQ A MIDFREQ</td>
<td>80</td>
<td>USB1-2 LEVEL</td>
</tr>
<tr>
<td>35</td>
<td>EQ A MID</td>
<td>81</td>
<td>USB3-4 LEVEL</td>
</tr>
<tr>
<td>36</td>
<td>EQ A HIGH</td>
<td>82</td>
<td>PLAYBACK MIX</td>
</tr>
<tr>
<td>37</td>
<td>EQ B ON/OFF</td>
<td>102</td>
<td>WAH POSITION</td>
</tr>
<tr>
<td>38</td>
<td>EQ B LOW</td>
<td>103</td>
<td>PDL ASSIGN</td>
</tr>
<tr>
<td>39</td>
<td>EQ B MIDFREQ</td>
<td>104</td>
<td>PDL MIN</td>
</tr>
<tr>
<td>40</td>
<td>EQ B MID</td>
<td>105</td>
<td>PDL MAX</td>
</tr>
<tr>
<td>41</td>
<td>EQ B HIGH</td>
<td>106</td>
<td>LFO1 ASSIGN</td>
</tr>
<tr>
<td>42</td>
<td>GATE ON/OFF</td>
<td>107</td>
<td>LFO1 MIN</td>
</tr>
<tr>
<td>43</td>
<td>GATE TYPE</td>
<td>108</td>
<td>LFO1 MAX</td>
</tr>
<tr>
<td>44</td>
<td>GATE ATTACK</td>
<td>109</td>
<td>LFO1 SPEED</td>
</tr>
<tr>
<td>45</td>
<td>GATE THRESH</td>
<td>110</td>
<td>LFO2 ASSIGN</td>
</tr>
<tr>
<td>46</td>
<td>GATE SENS</td>
<td>111</td>
<td>LFO2 MIN</td>
</tr>
<tr>
<td>47</td>
<td>FX ON/OFF</td>
<td>112</td>
<td>LFO2 MAX</td>
</tr>
<tr>
<td>48</td>
<td>FX TYPE</td>
<td>113</td>
<td>LFO2 SPEED</td>
</tr>
<tr>
<td>49</td>
<td>FX PARAM1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>50</td>
<td>FX PARAM2</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Factory Preset List

### Number | Artist Name | Preset Name | Number | Preset Name | Preset Name
--- | --- | --- | --- | --- | ---
1 | James Fuks | UF | 21 | Evil D | LUSH
2 | Dan Donegan | 2KR | 22 | Joey Z | LSHIP
3 | Dan Donegan | 2SH | 23 | Metal Mike Chlasciak | METAL
4 | Jennifer Batten | DMBF | 24 | Metal Mike Chlasciak | METAL
5 | Jennifer Batten | DMBR | 25 | Metal Mike Chlasciak | METAL
6 | Mike Einziger | MEUSB | 26 | Metal Mike Chlasciak | METAL
7 | Mike Einziger | MEUSB | 27 | Michael Wilton | CMED
8 | Clint Lowery | CLSF | 28 | Michael Wilton | CMED
9 | Clint Lowery | CLSF | 29 | Mark Rizzo | MKP
10 | Clint Lowery | CLSF | 30 | Andy LaRoque | ALP
11 | Chad Kroeger | CHMP | 31 | Andy LaRoque | ALP
12 | Chad Kroeger | CHMP | 32 | Dave Murray | DLP
13 | Carlos Caruso | CARPOS | 33 | Dave Murray | DLP
14 | CJ Pierce | CJPE | 34 | Dave Murray | DLP
15 | CJ Pierce | CJPE | 35 | Paul Crooke | CRK
16 | CJ Pierce | CJPE | 36 | Paul Crooke | CRK
17 | Dennis的事情 | OFH | 37 | Paul Crooke | CRK
18 | Glen Drover | GDROP | 38 | Ace Slade | ASE
19 | Jody Payne | JDP | 39 | Glenn Tipton | TIP
20 | Jody Payne | JDP | 40 | Glenn Tipton | TIP

### Appendix

#### Inputs:
- Guitar In: 1/4" Unbalanced
- Mic In: XLR Balanced w/Phantom Power
- Line Inputs: 1/4" Balanced TRS
- CD/Monitor: 1/8" Stereo TRS
- Footswitch: 1/4" Stereo TRS
- USB 1.1

#### Outputs:
- Line Outputs: 1/4" Unbalanced
- Line Outputs: XLR Balanced
- Headphone: 1/8" Stereo TRS
- USB 1.1

#### A/D/A:
- 24 bit Delta Sigma Converters

#### Drum Machine:
- 30 Patterns + Metronome

#### Simultaneous Effects:
- up to 11

#### Power Consumption:
- 10 Watts,
- Current Draw: 675mA AC

#### Power Supply:
- 9 VAC, 1300mA
- Digitech PS0913B - 100 (100V ~ 50/60Hz)
- Digitech PS0913B - 120 (120V ~ 60Hz)
- Digitech PS0913B - 230 (230V ~ 50Hz)
- Digitech PS0913B - 240 (240V ~ 50Hz)

#### Preset Memory:
- 40 User
- 40 Factory Artist
- 40 Factory

#### Effects:
- Pickup Simulator, Wah, Compressor, Amp and Acoustic Guitar Models, 3 band EQ, Noise Gate, Auto Swell, Pluck Gate, Cabinet Modeling, Mic Placement, Chorus, Flange, Triggered Flange, Phaser, Triggered Phaser, Tremolo, Panner, Vibrato, Rotary Speaker, AutoYa™, YaYa™, SynthTalk™, Envelope Filter, Pitch Shift, Detune, Whammy™, Delay, and Reverb.

#### Dimensions:
- 8.5" L x 13" W x 2.25" H
- Weight: 4.65 lbs.